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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©June 2021

Trademarks
Intel, Pentium and Intel Celeron are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:

+ Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Re orient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.

L_________________________________________________________________________________________________________________________________________________|
IV
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

N2
2

Warning

Use only shielded cables to connect I/0 devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be powered by the following AC/DC adapter, supplied with this computer model, in
accordance with the model’s power requirements::

Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19V, 3.42A (65W) minimum.

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

Do not placeit on an unstable
surface.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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3.

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Perform routine maintenance
on your computer.

Do not disassemble the com-
puter by yourself.

A=

2

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.

VIl
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Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from
the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

* If the computer has been exposed to rain or other liquids.

* If the computer does not work normally when you follow the operating instructions.

* [f the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» Ifthere is an unusual odor, heat or smoke coming from your computer.

\ A/
L&
Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and

screw(s) before restoring power to the system.
Also note the following when the cover is removed:

* Hazardous moving parts.
» Keep away from moving fan blades.
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Power Safety

The computer has specific power requirements:

ﬁ * Only use a power adapter approved for use with this computer.
* Your AC/DC adapter may be designed for international travel but it still requires a steady,
Power Safety uninterrupted power supply. If you are unsure of your local power specifications, consult

Warning your service representative or local power company.

Before you undertake * The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong
any upgrade proce- is an important safety feature; do not defeat its purpose. If you do not have access to a
dures, make sure that compatible outlet, have a qualified electrician install one.

you have turned off the * When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
power, and discon- its wire.

LCECl) E el AL » Make sure the socket and any extension cord(s) you use can support the total current load

and cables (including .
telephone lines and of all the connected devices.

power cord). * Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

You must also remove
your battery in order to
prevent accidentally Do not plug in the power Do not use the power cordif | Do not place heavy objects
turning the machine cord if you are wet. it is broken. on the power cord.

on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer/Lithium-lon Battery Precautions
Note the following information which is specific to Polymer/Lithium-Ion batteries only, and where applicable,
this overrides the general battery precaution information overleaf.

* Polymer/Lithium-Ion batteries may experience a slight expansion or swelling, however this is part of the battery’s
safety mechanism and is not a cause for concern.

» Use proper handling procedures when using Polymer/Lithium-Ion batteries. Do not use Polymer/Lithium-lon batteries
in high ambient temperature environments, and do not store unused batteries for extended periods.

» If you are working in areas of low temperature use the AC/DC adapter to power the computer.

See also the general battery precautionary information overleaf for further information.

Xl
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General Battery Precautions

* Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

* Do not remove any batteries from the computer while it is powered on.

* Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

* Ifyou do not use the battery for an extended period, then remove the battery from the computer for storage.

* Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

* Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

* Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

* Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

* Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

Xl



Preface

Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Cleaning Instructions

(For Computer Models Supplied with Light Blue Cleaning Cloth)
Some computer models in this series come supplied with a light blue cleaning cloth. To clean the computer case
with this cloth follow the instructions below:

Power off the computer and peripherals.

Disconnect the AC/DC adapter from the computer.

Use a little water to dampen the cloth slightly.

Clean the computer case with the cloth.

Dry the computer with a dry cloth, or allow it time to dry before turning on.
Reconnect the AC/DC adapter and turn the computer on.

ok wbN=~

Xl
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Travel Considerations
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it’s latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your “papers” are handy.

SN
L&

Power Off Before Traveling

ahwh=

No

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

XIv
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make

sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - [f an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

* Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

*  Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.

» Use a chair with a back and adjust it to support your lower back comfortably.

»  Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

» Take periodic breaks if you are using the computer for long periods of time.

Remember to:

* Alter your posture frequently.

» Stretch and exercise your body several times a day.

» Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XVI
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Lighting

Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

* Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

+ Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
» Position the display directly in front of you at a comfortable viewing distance.

* Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

* Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

» Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
* Rotate desktop background images every few days.

* Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos

Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVII



Preface

XVl



Preface

Contents

INOTICE vttt ettt ettt ettt ettt et et e bt et s et et e ea e e e st e bt em e e e bt embeea e e ee e em bt en e e bt em b e ee e e bt enbeen e e bt en b e ehe e beentenneebeenean I
ErP Off Mode Power Consumption StateMENT: .........cccvieeiiieeeiieeniieerieeeieeeeieeesteeesveeenereeesaneesseeessseeensnes II
FOC STAEIMENT .....eiiniiiiiiieee ettt ettt e ettt e it e e e bt e e ettt e sabteesabteesabeeeabeesabeeesanee 1AY
(Federal Communications COMMISSION) ....c..eevieriieeiuieriierieenieenreenseesseesseesssesnseesseeesseesseesseesseessseesseessseens v
FCC RF Radiation EXposure StatemMent: ..........c.cccovuieeiiieiiiieeiiieeiieeeieeeeieeesieeesteeesaeeeseeesaeeessseessssessnnnes \Y
Instructions for Care and OPETatiOn ..........ccceeiuiiriieiiieiiieie ettt ettt ettt e sate e bt e s eeebeesnbeenbeeseeas VII
SEIVICINE .evieiieeiieitie ettt e et et et e et e esbeesteesateesbeessaeease e seeasseesseessseesseaasseenseessseassaensseensaessseasseenseesnseenseensns IX
Lo N Y ] SRR X
Polymer/Lithium-Ion Battery PreCautions ...........ccooiieiiiiiiiiiieiiee et XI
General Battery PIrECAULIONS .........ccuiiiiiieiiieiiieieeeiieeiteeite et et e et eseteeteeteeesbeeteesbeesseeesseeseesnseenseeasseenses XII
L0 152 4 V1 o L SRS XIII
ClLeaning INSIIUCTIONS .....cocuiiiiieitieeiieiee ettt ettt et e sttt e bt e st e e bt e seteeabeesaeeesbe e beesaseebeeenbeeseesnseenneeens XTI
TTaVel CONSIACTATIONS ....euveeueiieieiieieeiiete ettt ettt ste et et ettt e e st e bt et e sate bt e st e eaeenbeentesaeenseeneenaeenees XIv
Quick Start Guide

OVETVIEW uviieeieee ettt e ette e e tee e st e e s teeessteeessseeeassaeasssaeassseeassseeassseeassseasseeasssaeasssseassseeassseeansseesssseesssenenssenanes 1-1
AVANCEA USEIS ...eviiiiiiiiiieiieeiie ettt ettt ettt e ettt e st e esbeestaeesbeessaeesseesseesnseesseeesseenseessseenseesssaesseanseensnas 1-2
Beginners and NON-AdvanCed USETS ........cccuiieiuiiiiiiiieiiiie e ecieeesieeeteestteesaeeessaeeessaeeessaeessseesseeessseeenns 1-2
WAINING BOXES .ottt ettt ettt et et e et eeae e et e e bt e e abeenbeeeabeebeeenseeseesnseenseeenseenneas 1-2
NOE INCIUAGA ..ttt ettt et e bt e e b e esaeesbeesbeessseensaessseesseessseensaessseesseensns 1-3




Preface

SYSTEIM STATEUD +.eveiniieiiieeteeete ettt ettt ettt et st e e s et et e e s et e e bt e s aeesateesaneenreessneeneenaneens 1-4
SYSLEM SOTEWATE ...ttt ettt et ettt e et e e bt e sabeebeeeateesseeesbeenseesnseenseesnseenseesnseens 1-5
MOAEL DIFTETEICES ...uvveiiieiiieeiiieiieeie ettt ettt et et s e et eeeaeebeestaeesbeeseeesbeesseeenseenseeesseenseessseeseeanseensnas 1-5
LCD Panel Open - MOdel A ...ttt ettt ettt e ettt e et esaeeebeeseeas 1-6
LCD Panel Open - MOdel B ....co.uoiiiiieeeece ettt ettt et e et e e enbeenenas 1-7
LED INAICALOTS ...evviiiieeiiieiieeiieeieeeteeteesiteeteeetteebeeseessseesseeesseesseessseasseessessseenseessseenseessseenssesnseenseessseenses 1-8
KEYDOATA ...ttt ettt ettt et e h e et e bt e et e e bt e eab e e bt e e ateenbeesnteenteas 1-9
[luminated Colored LED Keyboard ..........cccoooiiiiiiiiiiiiieeieeieee ettt 1-10
Function/Hot Key INAICALOTS ........ccouiiiiiiiiieiiieiieeie ettt ettt ettt e e e et e esbeesseaesseensneensaens 1-11
Keyboard Backlight LED DEVICE ......cceeiiiiiiiiiiiiiieiieeiie ettt ettt et ettt ebeaseeeebeesaeeens 1-12
CONITOL CRNLET ....vvieneieeiieeiie ettt ettt et et e st e e bt e s tte et e esaeeeabeeseesaseenseaesseensaesnseenseessseenseesnseenneeanne 1-13
FTONt & Left VIEWS ..eeiiiiiiiiicieeeeee ettt ettt ettt et e e et e e sabeesbeessaeensaesssaenseessseenseesnseens 1-14
RIZIE VIBWS ettt sttt et b ettt be e e et e sbe et eaeesae e 1-16
REAT VIBWS ...ttt ettt et e et e et e s ate e st e s sbeenseessbeenbeessseenseensbaenseanssesnsaennsaans 1-18
Bottom VIEW = MOAET A .....oiiiiiiieieee ettt ettt ettt e e e st esebeesbaeesseensaeesbaessaaenseensnesnseens 1-19
Bottom VIew - MOAEL B .......oiiiiiie ettt et et e et e et e e et e e e e e eareeennaeas 1-20
WiINAOWS 10 STATt IMEIU ..ovvvieiiiiiiieiiieeiie ettt ettt ettt et e e saeeesbe e b eesabeebeeenseenseesnseenseeenseensnesnseens 1-21
Right-Clicking the Windows Logo In Start MENU .........cccccceeriiiiiieriieiiieieeie et ens 1-22
Windows 10 Control PANEL ..........cooouviiiiiiiiiiicce ettt et e e e e e naeeenseeennneas 1-24
SELLINES ..eeiutietieeieeie ettt et et e it e et e e bt e bte e bt e bt e eabeenseeeaseenbeeaseeeabeenseeeabe et eeeabeenseeenbeenseeenseenbeennaeenneas 1-25
WINAOWS 10 TASKDAT .....viiiiieiiiiiiieiieeee ettt ettt ettt e e beeteeeabeesteeesbeesseeesseesseeenseenssesnsaens 1-26
F e 10 W O 1 1<) SRS 1-27

XX



Preface

VIAEO FEALUIES ....viiiiiiiiiiieciee ettt ettt e e e et e e ae e e tbeeestaeesssaeeassaeessseeensseeenssaeensseesnsseennnaens 1-28
POWET OPLIONS ..oiiiiiiiiieiieeiie ettt ettt ettt et e st e et e e s st e e beesabeesseassseenseessseenseassseenseessseenseesnseeseesnseens 1-33
Features & Components

OVETVIEW uviieeieee ettt e ette e e tee e st e e s teeessteeessseeeassaeasssaeassseeassseeassseeassseasseeasssaeasssseassseeassseeansseesssseesssenenssenanes 2-1
SOLIA SALE DITIVE ..ottt sttt ettt b et s bttt et sb e et e ebt e s bt e bt e st e ebeenbeentenaae e 2-2
MIiCTO SD Card REAAECT ......eiuiiiiiiiiieeiiete ettt sttt et sttt et e et e bt enteseeenaeenneas 2-3
Clickpad and BUttONS/IMOUSE ........ccuiieiiiieiiiiieeiieeeieeeeteeeeteeesereeetaeesraeesseeessseeesssesessseesssseessseesnsseesnsseenns 2-4
CIICKPAA SENSTLIVILY ..eiiutiiiiieiieiieeieesite ettt ettt ettt sit e et e e te e beesabeesbeessseenseesnbeenseassseenseesnseenseeenseenseas 2-4
Mouse Properties Control PAn@l ............cccooiiiiiiiiiiiiiiciiceee ettt sseeeneees 2-5
MouSe & ClICKPAA DEVICES .....ooviiiiiiiiiiiie ettt et ettt ettt e b e st e et esneeenbeesaeeenbeeneeas 2-7
Realtek AUAIO CONSOLE ...c..eiuiiiiiiiiiieiiteteee ettt ettt et s bttt st s bttt e beetesaee e 2-14
Realtek Audio COoNSOIE = IMAIN .....ecuiiiiiiiieieiieieee ettt ettt s e et et e et esbeeneesnee e 2-15
Realtek Audio Console - SPEAKEIS ......ooiiiiiiiiiiiiiie ettt ettt et et 2-16
Realtek Audio Console - MICTOPRONE .......ccouiiiiiiiiiiiiieiieeie ettt ettt eb e iaeeseesaeeens 2-17
Realtek Audio Console - Device Advanced SEtNGS ........cccveeveeriieriieiiieriieereenite et eseeeve e ereeree e e 2-18
Power Management

OVETVIEW ittt eite ettt et et e st et e ettt e ateeabe e tteaaseenseesabeenseaesbeeaseeasseenseensseenseessbeenseanssesnseesnseenseannsesnseas 3-1
THE POWET SOUICES ...oecviiiiiieiiieiieeiie ettt ettt et e et e et e st e ebeeesaeesbeessbeesseeesseenseessseesseansseensaessseenseensseesnas 3-2
ACTDIC AQAPLET .ttt ettt ettt et et e e bt e bt e et e e bt e e a b e e bt e eat e e bt e ent e e bt e enbeenbeeenbeenneas 3-2
BattOIY ittt e ettt e et e e bt e e s bt e e s a bt e e tbee e btee e nteeebteeebeeeeabeeenn 3-2
Thunderbolt 4 Combo Port with Power Delivery (DC-IN) ........cccoooieviiiiiieiieiiecieeieeee e 3-3




Preface

Turning On the COMPULET ......ccueiiiriiiiiieeeteee ettt ettt ettt ettt et sb ettt s bt e sbeeatesaeenaeennens 3-4
Shutting the COMPULET DOWI ....ooviiiiiiiiieiieeie ettt ettt ete e st e e be e seesabeenseeenbeensaesnseens 3-5
POWET PLANS ...ttt ettt ettt ettt ettt et e s bt et e eatesae et e entenbeentesaeens 3-6
POWET-SAVING STALES ...c..eitiriiiiiiiiiiere ettt ettt ettt ettt b ettt saeete et e saeenbeeanens 3-8
Sleep (Modern StandbY) ......c.cooiiiiiiiieiieie ettt ettt e et e s eaeeteesaeeeabeessaesabeenseeenbeensaeenseens 3-8
HIDEINALE ...ttt sttt et e bttt e h et e st e s a e e bt ea e e s bt e bt en b e bt et e entenbeentesaeen 3-9
SHUL QOWIL <.ttt et ettt e b e et e e bt e s st e e beeeaeeeabeesaeeenbeesateenbeesseesnseennneens 3-9
Configuring the POWEr BUIONS .......cooiiiiiiiiiiiieiiee ettt ettt ettt esae et eenae e s e ees 3-10
RESUMING OPETALION ...ocuviiiiiiiieiiieeiieeie et ertte et eteeeveeteesbeebeessseeseessseesseessseesseessseenseessseenseessseensaensseans 3-12
Settings Menu POWET CONIIOLS .......oiiuiiiiiiiieiieeiie ettt ettt et e bt e et eebeesneeenbeeseeas 3-14
Battery INTOrMAtION .....cc.iiiiiiiiiiie ettt ettt et e et e et e e s st e et eesaaeeseesabeenbeeenbeesaeenseens 3-17
Battery POWET ...ttt et e et e et e e et e e st e e e s atee e sbeeetbeeesaeeentaeeenneeennneenn 3-17
POWET SHAGT SETHNES ..ottt ettt ettt et s ae et et esbeeae e 3-18
Conserving Battery POWET .......cccuiiiiiiiiiiieieeicee ettt ettt ettt e et ee s te e bt e ssbeessaesnseesneeenne 3-19
BattETy LIT@ ..oeeeiiiiieeie ettt et ettt e et e e bt e e b e e b e e e tbeerbe e taeebaeetbeenbeenseeesaenareans 3-20
INEW BAIETY ...t ettt ettt e ettt et e e bt e e e bt e e eabbeesabte e s bt e e sabeeenaee 3-20
Recharging the Battery with the AC/DC AdAPLer ........cccuieiiiiiiiiiieeieeieee ettt 3-20
Proper handling of the Battery PACK ........c.ccociiiiiiiiiiicicce ettt 3-21
Battery FAQ ..ottt ettt ettt et e et e e e bt e e e bt e e e bt e e sabeeenaree s 3-22
Drivers & Utilities

WHAt 10 INSTALL ...ooiiiiiiiiii ettt ettt s e et e e te e s b e e teeesbeesseeesseenseensseenseensseenseas 4-1

XXII



Preface

Module Driver INSAIlAtION ....ccc.vvvviiiiiiiiiiiiiiiiiee e e e e e e et e e e e e s e st ab e e e e e s e s s sssrataeeeeeeeas 4-1
DIiver INSTALLAtION ........cooiiiiiiiieieiee ettt e ee e e e et e e et eeeeeaaeeeeeeaaeeeeeaseeeeeetrseeeeenneeeeans 4-2
Updating/Reinstalling Individual DITVETS ..........ccocuieiiiiiiiiiieeiicieece ettt 4-5
USET ACCOUNT CONIOL ..vvviiiiiiiiiiiiiiiiee ettt e e e e e et e e e e e e s s esaaaaeeeeeeesssssasbaaeeeeessssssssrataeeeeeeess 4-6
WiINAOWS SECULILY IMESSAZE ...eeevieuiieiieeiiietieetie et esiteeteestte e bt esteesaeeteeesaeenseassseenseessseenseesseesnseessseanseensnas 4-6
NEW HardwWare FOUNG .......cc..ooiiiiiiiieeeeec et e et e et e e e et e e e e earae e e e enaneeeas 4-6
Driver INStallation PrOCEAUIE .........eviiiiiiiiiiiiiiiiie ettt et e e e s s e st e e e e e e s s ssssataeeeeeeeas 4-7
CRIPSEE .ottt ettt ettt e bt e bt e et e e bt e sabeesbeeeaaeeabeeeabeea bt e seeenbeeente e bt e enbeenteeenbeenbeenneeenreas 4-7
NT= w1 1 (O SRRSO 4-7
VIO (INLE] VIGA) ettt ettt et ettt e b e et e bt e eab e e bt e enbeebeesnbeesaeeenseeneeas 4-7
AN e e e e e e ettt e e ee———eeeaa——aeeea——taeeai—aeeeeatraaeeaaraeeeearaeeeaann 4-8
O § 2T 1a 1<) TSRS ORPRRRURRPRRN 4-8
INtEI® HID FIIEET DITVET ..ottt ettt e e e e e e et e e e e s e s s esssataeeeeeeessssssrataeeeeeeeas 4-8
L070) 115 ¢0) N 0131171 OSSR ORPURSRROP PR 4-8
IMEL DIIVET ...ttt ettt e et e e e et e e e e eaae e e e e ataeeeeenaaeeeeeesaseeeeeasseeeensseseeeenseneeeennes 4-8
Intel® Dynamic PIatform DITVET .........cooouiiiiiiiiiiiee ettt ettt ettt 4-8
ThUNAEIDOIt DIIVET ...oeiiiiiiiiiieiiie et e et e e e e e e e eetar e e e e e taaeeeeeaseeeeeetrseeeeesneeeeans 4-9
ATAIO i e e e e —t e e ee——e e e e ——eeeea——tee e e —eeeeaattaeeeanateeeeaareeeaants 4-9
OPHONAL DIIVETS ...eoutiiiiiiiieeieet ettt ettt e et e bt e st e e bt e s ab e e bt e ssbeenbeesateeabeessbeenseesnseeneeenne 4-10
BIOS Utilities

OVETVIEW .nvtieiiieeiieeite et et e ettt etteeateestteetbe e st e esbeesaeesseenseeesseessaeasseesseessseesseensseensaeasseasseesseensaessseenseenssennsens 5-1




Preface

The Insyde BIOS ULIILY ...coouiiiiiiiiieieeeeet ettt sttt ettt st e b 5-2
Updating the BIOS / CPU .......oiiiiiiieieee ettt ettt sttt sttt e e et e sateenbe e seesnseesaaeenseenenas 5-3
UEFT BOOL ...ttt ettt ettt e h e b et e et et eat e e st et e ente s bt enbeeseesaeenseentenbeensesanens 5-4
Insyde BIOS Start SCTEEN .....cccuiiiiriiiiiiiiiecteet ettt ettt sttt et ettt saeenaeeane 5-5
Insyde BIOS Start SCTen OPLIONS: ....c..cceeeiuieriieeiiieiieeieeitteeteerteesteeteesttesseesseesbeesseesnseenseessseenseesssesnsens 5-6
BOOT MANAEET ....eeiiiiiiiiiiiiiiee ettt ettt e e ettt e e sttt e e e e bt e e e esabb e e e s ettt e e eaabbteeeenabbaeeeentaeeeenan 5-7
Boot From File / File EXPIOTEI ....ccocuviiiiiiiiiii ettt ettt tae e st e e ssve e e aveeeareeensaeennneeens 5-8
AdMINISTET SECUIE BOOT ....iiiiiiiiiiiertee ettt ettt st b e et sbt et e et saeenbe et 5-9
Setup Utility - MaAIN IMEIU ...oooiiiiiieiieeiieeie ettt ettt et et e st e ebeesaaeebeessseenseesssesnseessseenseenssessseensnes 5-11
Setup Utility - AAvanced MENU .......cc.cociiiiiiiiiiiiiiiiicee ettt st 5-13
Setup Utility - SECUTILY MO .....oouviiiiieiiieiieiie ettt ettt ettt ettt e et e b e et e e sateenbeessaesnseesseeenseennnes 5-20
Setup Utility - BOOT IMBINUL ....ooiiiiiiieiieiieeie ettt ettt sa e e e s v e enbaessaeenseessseensaenssesnseennnes 5-23
Setup ULty = EXIt IMIEIU ...eiiiiiiiiiiieiceteec ettt sttt st e 5-25
Modules & Options

OVEIVICW ....teutieiiettete ettt et ettt ettt et e e e st e s bt et e s et e ee e en bt ea e e ebeem et e st e bt eateeae e bt en b e eaeenbeenseesee bt enseentenbeennesaeens 6-1
SATA Mode Setup (Optane™, RAID Or AHCI) ..ocueiiiiiiiiieiiee ettt 6-2
AHCT MOGE ...ttt b ettt e b et e bttt et e e bt et e et e s bt et ea b e sbe et e eabenbeennesanens 6-2
INEEI® OPLANETM ......iiiiiieiieeie ettt et e et e et et e esbeeetaeesbeessaeesbe e seeesseenseeesseenseessseenseesnseenseeanseesnas 6-2
2N 1 D USSP 6-2
Intel® Rapid Storage Technology APPLICAtION .........c.eecuiiiiiiiiieriieeieeiie et 6-3
RAID SELUP eeieeiiieeeie ettt ettt e st e st e e st e e e tbeeensaeesssaeeansaeesseeenssaeanssessnsseennseeennseennns 6-5

XXIV



Preface

Deleting @ RAID ...ttt ettt et s e e b e st e et e e s ae e e bt e e abeeabeesabeebeeenbeeneeeateens 6-10
Intel® Optane™ Setup PrOCEAUIE .........oociiiiiiiiiiiiie ettt ettt et et e bt e siaeeseesaee e 6-11
WITRLESS LLAN .ttt ettt ettt et e bt e s e s a e bt e et e s et et e entesaeenbeentesaeenbeennenaeenee 6-14
Intel® WLAN Driver INStallation ...........ccoooioiiiiiiiiiieiee ettt et e 6-15
WLAN Configuration in WindowWs 10 ........cceeiiiiiiiiiiiieeiieiie ettt et et veesseesnneesaea e 6-16
Fingerprint Reader MOUIE .........c.oocuiiiiiiiiiiiiicece ettt ettt ettt be et e ssbeesteeesbeessaeensaens 6-19
Fingerprint Reader Driver INStallation ............cocooiiiiiiiiiiiii e 6-20
Fingerprint Module Confiuration ............coceeciiiiiiiiiieiieeie ettt ettt e et e b eseaeeseesaea e 6-21
BIUCTOOTH ...ttt ettt s h et et e bt et e st e sae ettt e bt et et e aeenee 6-23
Intel Bluetooth Driver INStallation ............coceoiiiiiiiiiie e et 6-24
Bluetooth Configuration in WINAOWS .........cciiiiiiiiiiiiieiieeie ettt ettt be e eseesaneens 6-25
To Make your Computer Discoverable to Bluetooth DevVICes ........c.ccccueeeiierieeiienieiiiciecie e 6-28
Intel® Speed Shift TeChNOlOZY DIIVET ....c..ooiiiiiiiiiiiiiiicec e 6-29
Speed Shift Technology Driver INStallation ............ccoocieiiiiiiiiienie e 6-29
Intel® Rapid Storage TEChNOLOZY .....ccceeecvieiiiieiiiiieeie ettt ettt et e et seaeebeesaseennaesaneens 6-30
IRST Driver INStAllation .......c.coouiiiiiiiieiie ettt ettt ettt e st e bt e e abe e s e ebeesaeeenee 6-30
Intel® Optane™ Memory & Storage Management ............ccccceeeruierieeriieneeeniienieenieesreesseesaeeseesseenseens 6-31
Enabling INtel® OPtaneT™ .............cccoeiiiiiiiieiiieiieiieeieeseeeteestteeteeseee e st esseessseessaeesseesssessseesseeesseesssesseens 6-33
Intel® Optane™ Memory & Storage Management for RAID Systems ........ccccocevveneeiiniencniicneenennne. 6-37
PC Camera MOAUIE .....c.eoiiiiiiiiiieiee ettt ettt ettt st et beeatesae e 6-46
L0110 1 AN o o OSSPSR 6-47
Taking Pictures/Capturing VIACO .........cccueeouiiiiiiiiiiiii ettt ettt ettt et sttt ae et e ate e eees 6-50



Preface

TR CAIMETA .....eviiieeiiiee ettt ettt e e ettt e et e e e st e e e esstaeeeeenssaeeeassseeeaasssaaesanssseaeansssseeeansssneesassneesannns 6-52
IR Camera Module ConfigUIation ...........ccociieiieiiieiiiieiieeie ettt ettt et e saeeseesabeebeessaeeseesaseens 6-53
Trusted Platform MOAUIE ..........oouiiiiiieiee ettt ettt 6-57
Enabling & Activating TPIM .........ooiiiiiiee ettt ettt ettt e bt e et e e saeeeateens 6-58
TPM Management i WINAOWS .......cccueiiieriieriieiiieiie et esiie et esiee et eseeesteeteessbeeseesateesseessseenseesnseenseennns 6-59
TP ACHIONS ..ttt ettt ettt et s et et e e e s bt e st e s et e bt ea e ea e et e eatesbeeneessee bt enteeaee bt ensesneenbeenees 6-61
Troubleshooting

OVEIVIBW ...ttt ettt ettt et ettt ettt h et s et e s bt et e at e sh e ea bt eat et e et e eht e bt eateeht et e eabeeb e e bt enbeebtenbeentesaeens 7-1
BasicC HINtS AN TIPS ..eeevieiieeiieiiieiiietieeee et site ettt e st ebe e e e e e beesaaeesbeesseeesseessaeenseenseessseenseessseensneanseenseas 7-2
Backup and General Maintenance .............oocuieiuiiiiieniienieeie ettt ettt e sttt e et esaeeebeesaeeeneeas 7-3
VIITUSES vttt ettt ettt ettt ettt et s at bt ea e e bt et ea e s bt et e eh e e bt e at e eh e et e eat e e bt et e ea b e bt et eh b e nhe et e ebtenbeeatenaeen 7-4
Upgrading and Adding New Hardware/SOftWare ..........c.cocueeeiieriiiiiiiiieciiceeee ettt 7-5
Problems and PosSible SOIULIONS ........cccuiiiiiiiiiiiiiciie ettt et et e e e e e stveeeaaeeesaeesaseeesnseeenes 7-7
Interface (Ports & Jacks)

NOtEDOOK POTES & JACKS ...ttt ettt ettt et eae e b enee A-2
Control Center

OVETVIEW .neiieiiieeiieeiee ettt e tte et e s tte e bt e e ateesbeessbeeaseesaeeaase e saeeaseenseeesbeenseesaseenseessseenseennseenseessseensaensseenseeseas B-1
POWET IMOAES ..ottt ettt et ettt e st e et e e s taeesbeessseesbaesseeesseensseensaessseenseenssesnsaenssennns B-4
[Muminated LED KeybDOArd .........coouiiiiiiiiii ettt sttt ettt et B-5

XXVI



Preface

Video Driver Controls

OVETVIEW ettt ettt ettt ettt et e ettt e bt e s et e eateeeaeeeab e e seeeat e e b eeeabeeaseesateenbeeesbeembeesabeenbeesseesabeenneeenseenseas C-1
Video Driver INStAllation .........ccooeiiiiriiiiiiiiiieen ettt ettt et eaees C-2
Configure Other Displays USING PrOJECE .....coiiiiiiiiiiieiieiieeiieiieeteeee ettt ettt ssaeeveeeenes C-3
You can configure attached displays from Project. .........ccocioiiiiiiiiiiiiiieeeee e C-3
Configuring an External Display In WINAOWS .......cccuiiiiiiiiiiiiiiiiieiee et C-4
HDMI Audio CONTIZUIALION .....ccueeieiieiieriieeieeeiieeieeiteeieesteeeteesteeesteeseessaeesseessseeseessneesseesssesnseenseessseenses C-6
Wireless Display ConfiUration ...........coccoceiiiiiriiiiinierteeeeee ettt st C-9
Intel® Graphics COMMANA CENLET .......cecvieriiiiiieiierieeitete et et et estte et eeeesbeebeeseseeseessaeenseessneenseens C-11
DisSplay DeviICes & OPLIONS .....eecvieiiieeiiieiiieiieeitiesieerteeseeeteestteesteesseeeseesseesseesseeasseesseessseesseessseesseesses C-23
Attaching Other DISPIAYS ...c..ooiiiiiiiiiiiiiieeeet ettt sttt sttt sbe et e nae e C-24
Specifications

DISPLAY ittt ettt et e et e tb e e bt e et be e b e e atbe e ba e taeenbeeasaeebeentbeenbeenseeenreeneeenne D-2
IMLEIMOTY ..ttt e et ettt e s et e e bt e e e bt e e e ab e e e s ab e e e bt e e e bt e e e bt e e sabbeesabeeennbeesnbeesabaee e D-2
STOTAZE ..veeeueteeeiieeetie ettt ettt ettt e ettt e ettt e sttt e s at e e e st e e easteesabaeeeabee e st eeensbeesnsteesnseeesaseeesabeeennbeeenbeesaneeesanes D-2
F N 14 (o SO OO SRR D-2
Pointing Device & KeyDOArd ..........c.oouiiiiiiiiiee e D-2
INEEITACE ..ttt ettt a e h et e a e b e et h bt e a e bt e b et h bt ebeentes D-2
Card REAGCT ...ttt ettt ettt et e h e bt e it e s h et e et e s bt et e st e bt eteeetenaeentea D-3
N1 (o] OO OSSOSO PTRUSRUSRORRRRORT D-3
COMIMUINICALION ..vttiteiteie ettt ettt ettt sh ettt ettt ea e e bt e st e e bt e s bt et e eb e e bt e st e sbee bt eatesbeenbeesbesbeebessaesaeenneas D-3



Preface

POWETr MANAQ@EMENL ....co..eiiiiiiiiiiiiiie ittt ettt ettt e et e st e e s it e e e sab e e e ebbeeebteesbbeesareens D-3
POWET & BALLETY ..eoniiiiiiieeeie et ettt ettt e s e et e e s tb e e e bt e e sabteesabteesabeeesabeesnnneeens D-3
SEOUITEY .veiutietieeiteitte ettt ettt e et e et e e etteebe e teeesbeeseessseesseeesseanseesaeessaesseeesseensaensseenseessseenseensseasseenssennseans D-3
FRALUTES ...eveieiiiiiee ettt e et e e e sttt e e e e taaeeeesasbeeeeasaaaeeaassaeeesessseeeeeansseaeeansseeeennssneeeanns D-3
OPETALING SYSLEITL ..uvviiiiieiiieiie ettt et ett e et estte et estteesbeesteeeateeseessseesaessseenseessseensaessseenseessseenseessseenseensnes D-3
INAICALOTS .ntieuieiietiete ettt ettt et h et e et e et e bt e et e bt et e e st e bt en e e es e e bt enteeae e bt enteseee bt enteeneentes D-3
57 (0 RSSO D-3
ENVITONMENTAL SPEC ..ottt ettt et e st e et e st e e bt essbeebeesseeenbeessseenseesnseenne D-3
DiImensions & WEIGNE .....c.oooiiiiiiiiiieiee ettt ettt e e s e e beesaaeesbeessaeenseeseeenseennes D-4

XXVIII



Quick Start Guide a

Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (SSD and card
reader), Clickpad & Mouse & Audio.

* Chapter 3  The computer’s power saving options.

* Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

* Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

* Chapter 6 A quick guide to the computer’s PC Camera, Wireless LAN, Combo Bluetooth & WLAN and
Intel modules (some of which may be optional depending on your purchase configuration).

* Chapter 7 A troubleshooting guide.

* Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

» Appendix C Information on the Video driver controls.

» Appendix D The computer’s specification.

. |
Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page4 - 1 and “BIOS Utilities” on page5 - 1 in the remainder of the User’s
Manual. You may also find the notes marked with a /2 of interest to you.

Beginners and Non-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
d the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detail.ed descriptions of the functions, setup and sys.tem controls are covered in the
boxes with the mark | remainder of the User’s Manual), but do not worry if you do not understand every-
above to find detailed in- | thing the first time. Keep this manual nearby and refer to it to learn as you go. You
?Jg?g?g;:;ﬁ the com- may find it useful to refer to the notes marked with a #as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2% symbol. Also please note the safety and handling instructions as indicated in the Preface.

1 -2 Overview
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Not Included

Operating Systems (e.g. Windows 10) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Interface (Ports & Jacks)” on page A - 1 for a description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3
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System Startup

1.  Remove all packing materials, and place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

3. When first setting up the computer use the following procedure (as to safeguard the computer during
shipping, the battery will be locked to not power the system until first connected to the AC/DC adapter and
initially set up as below):

N

» Attach the AC/DC adapter cord to the DC-In jack on the left of the computer, then plug the AC power cord into an outlet, and connect
the AC power cord to the AC/DC adapter and the battery will now be unlocked.

4. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other
hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

5. Press the power button on the right side of the computer to turn it on (note that the lid/LCD must be open for
the power button to function).

4

Shutdown

Note that you should
always shut your com-

puter down by choos-
ing the Shut Down
command in Win-
dows. This will help

. a . . . i} prevent hard disk or
Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-in system problems.

A v

1 - 4 System Startup
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System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 10 (64-bit) operating system
is supported.

4

Windows OS

Note that the information included on the following pages is for Windows 10 only.

In order to run Windows 10 (64-bit) your computer requires a minimum 8GB of system memory (RAM).

Model Differences

This notebook series includes different model designs based on specification, and these may also vary slightly
in appearance. Note that though your computer may look slightly different from that pictured throughout this
manual, all ports, jacks (other than those indicated in the specification) and general functions are the same for
all the design styles (see Appendix D for further details).

.|
System Startup 1 -5
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Figure 1 -2
LCD Panel Open

1. Built-in PC Camera
OR

Windows Hello
Infrared Camera
(Factory Option)
PC Camera LED
Built-In Array
Microphone

LCD

Keyboard
Clickpad & Buttons
Fingerprint Reader
Sensor (Factory
Option)

@wnN

No ok

Note that the Clickpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines on the right.

The terms Clickpad and
Touchpad are interchange-
able throughout this manual

N\ A/
2 &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic  transmission
devices aboard aircraft is

usually prohibited. Make
sure the WLAN & Blue-
tooth are OFF if you are

using the  computer
aboard aircraft by putting
the system in to Airplane
Mode (see
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Figure 1 -3
LCD Panel Open

1. Built-in PC Camera
OR
Windows Hello
Infrared Camera

(Factory Option)
2. PC Camera LED
3. Built-In Array
Microphone
4. LCD
5. Keyboard

6. Clickpad & Buttons

Note that the Clickpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines on the right.

The terms Clickpad and
Touchpad are interchange-
able throughout this manual.

LCD Panel Open - Model B1 -7



D Quick Start Guide

LED Indicators

The LED indicators on the computer display helpful information about the power status of the computer.

Icon Color Description
Orange DC Power is Plugged In (Computer is Off)
D/d) Green The Computer is On
Blinking Green The Computer is in Sleep Mode
Orange The Battery is Charging
|‘: ”l Green The Battery is Fully Charged
Blinking Orange The Battery Has Reached Critically Low Power Status

Table 1 -1 - LED Indicators

1 - 8 LED Indicators
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Keyboard &

The keyboard has a numerical keypad for easy numeric data input, and function keys
to change operational features instantly. See Table 1 - 2, on page 1 - 11 for full func-
tion key combination details. If your keyboard is dam-

aged or you just want to
I3 P2 F9 F Fa) Fd P P Fd P D ) EICIE D | oy sandars s
ERRRRCARRE
> L Y UL T

Other Keyboards

B D keyboard. The system will
- detect and enable it auto-
SR )« () (v ) ) - ) 2| | e

NumLk Keys Home cial  functions/hot-keys
[=-](2) (=) =] (=) (=) ) () (<) [ ] g i koyboard may no

. regular keyboard may not

i Numerical
[ [ -] n work.
LFn Kem . @ . . m MenulAppllcatlon Key @ E Keypad
ScrLk
BRI v oo TE B ENRIBREN
R— Hold down the Fn Key

. and ScrLk to enable scroll
Figure 1 - 4 - Keyboard lock, and check the LED
indicator for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.

These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.

Keyboard 1 -9
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~ llluminated Colored LED Keyboard

The (optional) illuminated colored LED keyboard has an embedded numerical
keypad for easy numeric data input, and features function keys to allow you to
If your keyboard is dam- | change operational features instantly. See Table 1 - 2, on page 1 - 11 for full function
aged or you just want to key combination details.

make a change, you can
use any standard USB - )
keyboard. The system will - m [?] m m [?] [?] [?] [T] [T‘ m [F“ ] [ﬁ:” : roas
detect and enable it auto- "~_‘ Functlon Keys
matically. However spe- = . 5 B - . E] l
ma] functlons/hot-kexs PIaylPause Key JI® Scrlk &
unique to the system’s e — NumLk K

um eys

;«;grukllar keyboard may not E]:j[:ﬂg .E]E .:]E B - -
Sertk 1 [EENENENENENE -r. oo <o [

Hold down the Fn Key

and ScrLk to enable scroll I_J D j ‘] D D LJ D j U D . :

lock, and check the LED
indicator for status. Figure 1 - 5 - llluminated Colored LED Keyboard

4

Special Characters

Other Keyboards

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.

1 - 10 llluminated Colored LED Keyboard
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Function/Hot Key Indicators

Keys Function Keys Function
Displa
Play/Pause (in Audio/Video Programs) Fn + B8 Brigh,t)neyss I
Decrease/
*Fan Control Toggle
En + Automatic Fan KD Fan sreen K{) Fam spren PCP%:/Z?ra
" pluomats Fan | g - s | < o]
P Toggle
ower
*Note: It is recommended that you use Maximum fan speed when Fn + [Fif Airplane Mode [ 4 Airplane mode off |
playing games. 3 Toggle
Fn + [F2 Turn LCD Backlight Off Number Lock
B (Press a key to or use Clickpad to turn on) Toggle
3 Scroll Lock
Fn + ® Mute Toggle I Toggle
Volume Decrease/ Caps Lock
Increase Toggle
. ) . | Power Modes
Change Display Configuration Fn +3 s | Toggle
Control Center Toggle Table 1 - 2 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 11
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Keyboard Backlight LED Device

(For llluminated Colored LED Keyboards - Optional)

Press Fn plus the [ -] @ key to toggle the keyboard LED on/off. The keyboard LED may be configured using
the Fn + key combination outlined in the table below. In addition press Fn plus the [« 0 key to launch the
keyboard backlight application to configure the settings.

Main Keyboard Colored LED Function key Combinations

Fn+[7) @ Launch the Keyboard Backlight (9]
[} -

Application i Y i i
Toggle the Keyboard Backlight LED On/ 7 8 =]
Fn+ [q e 99 y Off 9 Home u Pglp

Fn + @ Keyboard Backlight LED Low 1 —
End Y

Fn+ " O Keyboard Backlight LED High [ > ] [ o J [ ]

Table 1 - 3 - Main Keyboard LEDs (for llluminated Colored Keyboards Only)

1 - 12 Keyboard Backlight LED Device
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Control Center

Run the Control Center from the Windows Start menu or use the Fn + Esc key combination,
or double-click the icon n in the notification area of the taskbar. The Control Center provides quick access to
Power Modes, Fan settings and LED Keyboard (for optional white illuminated keyboards only) configuration
(see Appendix B).

(& Bl Note the LED Key-
board item will ap-
pear for colored LED
keyboards only.

SoOOTROL canTEr 5.0

(s

COoOMNTROL CanTER 5.0

Figure 1 - 6 - Control Center

Control Center 1 -13
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Figure 1-7
Front & Left Views

DC-In Jack

HDMI-Out Port

USB 3.2 Gen 2

(Type A) Port

4. USB3.2Gen?2
(Type C) Port

5. Thunderbolt™ 4

Combo Port with

Power Delivery

DC-In (Type C)

wnN =

Front & Left Views

Model A

Model B
—_—

Model A

|
J!_,P
poggooQoQooegd b

USB Ports
This model includes 1 * USB 2.0 (Type A) Port, 1 * USB 3.2 Gen 2 (Type A) port, 1 * USB 3.2 Gen 2

(Type C) port and 1 * Thunderbolt™ 4 Combo Port with Power Delivery DC-In (Type C). See
“Notebook Ports & Jacks” on page A - 2.

Optical Device Drives

To install applications and drivers etc. you may need to attach an external optical CD/DVD device to
the USB ports.

1 -14 Front & Left Views
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L&
Thunderbolt Port Devices

When plugging a device into a Thunderbolt port allow 30 seconds for the system to scan and recognize
the connected device. Double-click the Thunderbolt Control Center u hur in the
Start menu.

Ejecting Thunderbolt Devices

In order to prevent system problems make sure you do not simply pull the cable out from the Thun-
derbolt port. The hardware must be ejected safely:

Go to the notification area of the taskbar in and click on the Safely Remove Hardware and Eject
Media icon.

Click on Eject “Thunderbolt Device Name”.

When you see the “Safe to Remove Hardware” message you can remove the cable after
about 20 seconds, to make sure that it is safe to eject the device.

Front & Left Views 1 -15
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Figure 1 -8
Right Views

1. 2-In-1 Combo
(Headphone/
Microphone)
Audio Jack

2. Micro SD Card

Reader

USB 2.0 (Type A)

Port

LED Indicators

Power Button

RJ-45 LAN Jack

Security Lock Slot

Vent/Fan Intake/

Outlet

w

PN O

Right Views

Model A

&

USB Ports
This model includes 1 * USB 2.0 (Type A) Port, 1 * USB 3.2 Gen 2 (Type A) port, 1 * USB 3.2 Gen 2
(Type C) port and 1 * Thunderbolt™ 4 Combo Port with Power Delivery DC-In (Type C). See

“Notebook Ports & Jacks” on page A - 2.

Micro SD Card Reader
The compatible MicroSD card formats are listed below:

*  microSD / microSDHC / microSDXC

1 - 16 Right Views
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4

Combination Audio Jacks
Note that the combination audio jacks can support headphones or headsets (i.e. a combination microphone/headphone).

1. When a device is plugged in to the combination audio jack a a dialog (“Which device did you plug in?”) box will pop-up

©@ Which device did you plug in?
Headphone

Headphone Headset

2. Make sure you select the correct device from the drop-down menu corresponding to the device plugged-in (e.g.
choose “Headset” if you have plugged-in a headset and do not choose headphone in this case), and then click OK

to save the setting.
3. If you are plugging in a microphone then use the Microphone Jack, and do not use the combination audio jack.

.|
Right Views 1 - 17
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Figure 1- 9 Rear Views
Right Views Model A
1. Vent/Fan Intake/Out- o —
et w.i
Model B

1880I00000000060

2N
I

Overheating

To prevent your computer
from overheating make sure
nothing blocks the Vent/Fan
Intake while the computer is
in use.

1 - 18 Rear Views
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BOttom VieW = MOdel A Figure 1 - 10

Bottom View

1. Speakers
2. Vent/Fan Intake/
Outlet

N/
2§
Bottom Cover Removal
Warning

Do not remove any cover(s)
and /or screw(s) for the pur-
poses of device upgrade as
this may violate the terms of
your warranty.

If you need to replace/re-
move the SSD(s) or RAM for
any reason, please contact
your distributor/supplier for
/ further information.

Overheating

To prevent your computer
Always completely discharge, then fully charge, a new battery before using it. Completely from overheating make sure
discharge and charge the battery at least once every 30 days or after about 20 partial dis- nothing blocks the Vent/Fan

charges. See “Battery Information” on page 3 - 17 for full instructions. Intake while the computer is
in use.

Battery Information

Bottom View - Model A1 -19
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Figure 1 - 11 Bottom View - Model B

Bottom View

1. Speakers
2. Vent/Fan Intake/
Outlet

N/

/ﬂ\ frati] &

Bottom Cover Removal
Warning

(]

Do not remove any cover(s)

and /or screw(s) for the pur-
poses of device upgrade as _E_ ‘
this may violate the terms of ‘E

your warranty.

)

If you need to replace/re-

move the SSD(s) or RAM for @
any reason, please contact
your distributor/supplier for
further information.

Overheating

To prevent your computer
from overheating make sure

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 17 for full instructions.

nothing blocks the Vent/Fan
Intake while the computer is
in use.

1 - 20 Bottom View - Model B



Windows 10 Start Menu

Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start
Menu by clicking the icon §g in the taskbar in the lower left corner of the screen (or by pressing the Windows
Logo Key 2@ on the keyboard). The Start Menu will contain a number of apps, and many more will be installed
as you add more applications etc. Not all of these apps may fit on the screen so you can use the scroll bar to move

up and down the screen.

Windows Screens

Note

4

the Windows

screens on the following pag-
es are included as a basic
guide and introduction to navi-

gating around Windows 10.

However note that these
screens are always subject to
change, upgrade and rede-
sign. Check the Microsoft
. website for details.

] ': [ype here to search

Figure 1 - 12 - Windows Start Menu

Quick Start Guide a

Windows 10 Start Menu 1 - 21
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Right-Clicking the Windows Logo In Start Menu

Right-click the Start Menu g@ icon (or use the Windows Logo Key &3 + X key combination) to bring up an
advanced Context Menu of useful features such as Apps and Features, Power Options, Task Manager, Search,
File Explorer, Device Manager, Computer Management and Network Connections etc.

Apps and Features

Mobility Center
Power Options

Event Viewer

System

Device Manager
Network Connections
Disk Management
Computer Management
Windows PowerShell

Windows PowerShell (Admin)

Task Manager
Settings

File Explorer
Search

Run

own or sign out

S . = z
Figure 1 - 13 - Right-Click Windows Logo in Start Menu
L_________________________________________________________________________________________________________________________________________________|

1 - 22 Windows 10 Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu

To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on a program’s icon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. You can use the same method to pin apps/pro-
grams to/from the taskbar (select pin to taskbar/unpin this program from the taskbar).

Recently added Productivity
penOffice Writer

~  OpenOffice

B OpenOffice Math

Expand >

) Run as administrator

#*
roubleshoot compatibility
3D View
Pin to Start @ o

Ea Scan with Microsoft Defender... Reorer
RF  Alarms & Clock

& Unpin from Start

More

Pin to taskbar

Uninstall

Restore previous versions
el ey Microsoft Storeny  Washington, ..

Send to >
S Calendar
Cut 5 Q
Camera
Co .
Py | Control Center 3.0 Stk
Create shortcut < Cortana
Delete
Rename
Fan Speed Setting
Properties ™

O Type here to search

Figure 1 - 14 - Pin to Start/Unpin from Start

Windows 10 Start Menu 1 - 23
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Windows 10 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of ways in Windows 10.

 Select Control Panel
under the Windows
System item in the
Start Menu.

Web More v

Apps Documents

| Control Panel
App

Aps

» Type Control Panel

Bl Settings >
into the Search box in e
the taskbar and click & s em 5 i
on the 1con When 1t & Taskbar notification area >
pops up. @ See if you have a 32-bit or 64-bit > Recent
version of Windows = g
* You can pin the Con- Search the web 0 o

trol Pan€ tile to Start
or taskbar.

L Control panel - See web results >

B Tk Manager
o i
5 isee

R e e
22 liype here to search

O Control

panell > 4

Figure 1 - 15 - Windows 10 Control Panel Access

1 - 24 Windows 10 Control Panel



Settings

Quick Start Guide a

The Settings item in the Start Menu (and also as an App) gives you quick access to a number of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Apps,
Accounts, Time & language, Gaming, Ease of Access, Privacy and Update & security.

123

Documents

Pictures

Settings

Power

5 [iype here to search

Productivity

Microscft Edge

Explore

Mostly Clear

| vy

Microsoft Store ~ Washington,...

(4}

Solitaire

Microsoft To...

Settings

System

Network & Intemet

Arcounts

Ease of Access

Update & Security

Figure 1 - 16 - Settings

Windows Settings

LTﬁ Devices

Eﬁ Persanalization

(Ch,  Time & Language

/D Search

fincdows isn't actvated. Activate Windows ne

Phane

Apps

Gaming

Privacy

Windows 10 Control Panel 1 - 25
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Windows 10 Taskbar

In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Hl O Type here to search

Taskbar

L Type here to search

Taskbar - Pinned Programs and Apps Notification Area
Figure 1 - 17 - Taskbar

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “ Pining/
Unpinning Apps & Programs to/from the Start Menu” on page 1 - 23).

1 - 26 Windows 10 Control Panel
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Action Center

The Action Center appears as a vertical panel on the right side of the screen (click Expand to view the full pan-
el) when you swipe in from the right or click the button in the notification tray. This gives you access to com-
monly needed functions like Network, All Settings, Airplane Mode, and Project etc. The Action Center also
contains a Brightness slider when expanded.

Collapse

Tablet mode Location Bat save Night light

L e o @

Mobile hotspot  Airplane mode  All settings Network

= fou o p)

Connect Project VPN Alarms only
@

Screen snip
Expand

Al

) A Ee3 ESS
Tablet mode Location attery sa Night light

Figure 1 - 18 - Action Center

, L51PM

. |
Windows 10 Control Panel 1 - 27
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Video Features

You can switch display devices, and configure display options, from the Display Settings control panel (see
over). In Windows 10 it is possible to quickly configure external displays from the Project menu (press the Win-
dows logo key g@ on your keyboard and the P key).

To Configure Displays using Project

1. Attach your display to the appropriate Project
port, and turn it on.

2. Pressthe g@ + P key combination.

3. Click on any one of the options from
the menu to select PC screen only,
Duplicate, Extend or Second
screen only.

4. You can also click Connect to a
wireless display at the bottom of the
Project screen and follow the steps
to connect to any wireless enabled
display.

PC screen only

Duplicate

Second screen only

Figure 1 - 19 - Project (Devices)

1 - 28 Video Features
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To access the Display Settings:

1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings.

2. Adjust the settings for Brightness and color, Scale and layout, Resolution and Orientation from the menus.

3. When and external display is attached you can arrange the display configuration from the Multiple Displays
menu, and arrange the configuration from Select and rearrange displays.

4. Click Apply to save any changes made.

L= Setbngs «
View > Display
@ Home Displa :
Sort by > Klay Rearrange your displays
Find 5 setting
Refresh | | Brightness and color Select a display below to change the settings for it. Press and hold (or select) a display.
System then drag to rearrange it
D Change brightness for the built-in display
v
o = Display v
Paste shortcut Paht fiaht
44 sound e on
Mew > Naght light settings
“ (| £ actions
q Display settings ’ D Focus assist Windows HD Color
e y
@ Power & sieep
= Battery Apply Cancel Identify Detect
= Storage Scale and layout
B Tablet ?'-..‘mi.- the size of text, apps. and other items Multlple displays
100% (Recommended)
B mMuttitacking s P Duplicate these displays
& Projecting to this PC Display resclution Extend these displays
% Shared P — 1920 >‘ 1080 (Recommended) Show on\y on 1
Display orientation
Clipboard i 1 Show only on 2
Landscape
3% Remote Desktop Display adapter properties
Multinle dienlaus

Figure 1 - 20 - Display Settings

Video Features 1 - 29
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To access the I ntel(R) Graphics Command Center:

1. Access the Intel Graphics Command Center from the Start menu in Windows.
2. You can right-click the Intel Graphics Command Center in the Start menu and pin the control panel to Start
and/or taskbar.

= Feedback Hub Thursday

Fn hotkeys and OSD ! O

Get Help

Groove Music

8 Uninstall

Hidden City: Hidden Object Adventu... Explore Explore

Caleulator Microsoft Store

Hulu

Ea ¥
&

® ré i
Intel® Graphics Command Center e B

New

Mail

Maps

@ & D EE

Microsoft Edge

Microsoft News

Microsoft Solitaire Collection

Figure 1 - 21 - Intel® Graphics Command Center
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Advanced video configuration options are provided by the Intel Graphics Command Center.

Games ah U‘n_ig.l) Connected Displays

Identify  Detect  Apply  Help

The Perfect Experience

Awaits You

o &n your screen.

creen is updated

Video Modes Restore to Original Settings

Figure 1 - 22 - Intel® Graphics Command Center

Video Features 1 - 31
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Minimum Screen Resolution Settings

1. Windows 10 has minimum screen resolution requirements.

2. Right-click a blank area of the Desktop and select Display Settings.

3. Adjust the Display Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or

above.
- Séttinge (=] =
@ Hame Display
| Find a setting - I
Scale and layout
’ Change the size af text, apps. and other items
100% (Recommendecd)
| O oisplay o
Advanced scaling settings
) Sound
1280 = 1024 (Recommended)
[ Notifications & actions 1280 = 960
1280 = 800
D Focus assist
1280 ~ 768
) Power & sieep 1280 * 720
1280 = 600
= Banery
1152 = BG4
= Storage 1024 = 768
BOO = 600
G Tablet

] Make this my main display

Eit Muttitasking

st Lo o wirehess display

& Projecting to this PC ay settings

% Shared experiences
A chipboard

3 Remote Desktop

Sleep better

Figure 1 - 23 - Display (Resolution)
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Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can also add Hibernate/Sleep to
the menu - see page 1 - 34). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Using the Power Button

1. Go to the Start Menu.

2. Click the Power button .

3. Select the power state required from
the menu.

E Calculator

Clgodar

Sleep
Hibernate

Shut down

Figure 1 - 24 - Shut Down/Restart

Power Options 1 - 33
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You can also use the context menu (right-click the Start Menu g icon or press the Windows logo 2@ + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

4

Adding Hibernate/Sleep to the Power Men

Go to the Power Options (Hardware and Sound) control
panel (or go to Windows Settings > Power & sleep >
Additional power settings).

Click Choose what the power buttons do.

Click “Change settings that are currently unavailable”
'?:!' Change settings that are currently unavailable .

Click to put a check in the Hibernate/Sleep box under
Shutdown settings.

Click Save Changes and close the control panel.

Figure 1 - 25 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination

You can use the CTRL + ALT + DEL key combination to bring up a full-screen displaying Lock, Sign out,
Change a password, Task Manager and Switch User. If you click the Power icon in the lower right corner of
the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.

.|
1 - 34 Power Options



Features & Components

Chapter 2: Features & Components a

Overview

Read this chapter to learn more about the following main features and components
of the computer:

» Solid State Drive

* Micro SD Card Reader

* Clickpad and Buttons/Mouse
* Realtek Audio Console

. |
Overview 2 - 1
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e Solid State Drive
L%

Bottom Cover The solid state drive (SSD) is used to store your data in the computer. The SSD can
Removal Warning be taken out to accommodate other SATA SSDs, however you will need to contact
your distributor/supplier to do this in order to avoid violating the terms of your war-
ranty (see “ Storage” on page D - 2 for specification information).

Do not remove any cov-
er(s) and /or screw(s) for
the purposes of device
upgrade as this may vio-
late the terms of your

warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

2 - 2 Solid State Drive
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Micro SD Card Reader

The card reader allows you to use Micro SD storage cards. Push the card into the slot
and it will appear as a removable device, and can be accessed in the same way as
your hard disk (s). Make sure you install the card reader driver (see “ CardReader”

on page4 - 8).
The compatible MicroSD card formats are listed below:

e microSD / microSDHC / microSDXC

Figure2-1
Right View
1. Micro SD Card
Reader
o8
0% Lo =5 e, & oo

\l fiougogogug

Micro SD Card Reader 2 - 3
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Clickpad and Buttons/Mouse

The Clickpad is an alternative to the mouse; however, you can also add a mouse to

, your computer through one of the USB ports. The Clickpad buttons function in much
1 OICSE 10 PIOVE Pac [ two-butt te the terms Clickpad and Touchpad
o iy the same way as a two-button mouse (note the terms Clickpad and Touchpad are
sary to keep the surface interchangeable throughout this manual).

clean and free of finger- . .
prints and marks etc. Clickpad Sensitivity

The mouse button zones at the bottom of the pad are defined by the line at the bot-

2N
1§

Clickpad Cleaning

Use a soft dry cleaning . .. .
cloth to keep the pad tom of the pad, and the left and right buttons are divided roughly down the middle.

surface clean. Press the left button zone for a left click, and right button zone for a right click ac-
Disabling the Pad tion.
Use the Fn + F1 or Con- T s —— 4
trol Center button to dis- |
able the Clickpad. | Mouse Driver
\ If you are using an external
| mouse your operating system
Figure 2.2 \ may be able to auto-configure
lick Zones @ | e e e your mouse during its installa-
Clickpad Zones [/ =—=========="] || tion or only enable its basic
| 1 functions. Be sure to check
, Left Button Zone  |I,Right Button Zone the device’s user documenta-
v W tion for details.

2 - 4 Clickpad and Buttons/Mouse
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Mouse Properties Control Panel .
Y/ \Y
You can configure the functions from the Mouse control panel in Windows as fol- o
Disabling the
lows. Cli
ickpad

1. Right-click the Start Menu g icon.

2. Select Control Panel under the Windows System item in the Start Menu.
3. Click Mouse (Hardware and Sound > Devices and Printers).

4. Click the menu headings tabs to adjust your mouse preferences.

If you need to disable
the Clickpad for any
reason (e.g. you may
find that when using

@ Mouse Properties X the COmpUter‘S internal
keyboard you acciden-
tally trigger the Click-

Buttons  Pointers  Pointer Options Wheel Hardware

s it pad when resting your

[[] switch primary and secondary buttons o q
i wrists or palms on it)
Select this check box to make the button on the q
right the one you use for primary functions such as g you can do so by using
RS 2R S, Fn + F1 key combina-
tion.
Double-click spead

Double-click the folder to test your setting. If the
folder does not open or close, try using a slower

setting.
Speed:  Slow ' Fast

ClickLock Figure 2 - 3
I:lqun on ClickLock Setiings... Mouse PrOpertleS
Enables you to highlight or drag without holding down the mouse button. Control Panel -
To set, briefly press the mouse button. To release, click the mouse
button again. Buttons

s |

Mouse Properties Control Panel 2 - 5
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Figure2-4
Mouse Properties
Control Panels

a Mouse Properties

Butions Ponlers  Pomior Options  Wheol  Hardware
Sehame

Windows Delaut (System schama)

a Mouse Properties

Mation

Butions  Poiniers  Powiler Options  Wheol  Hardware

& Seloct 8 porior speed:
Slow Fast
SavoAs.. Deloso L
4] Enhanca pointor precisicn
Customize: SowpTo
Hulp Seloct v
Working In Background e Viskity
i fo) [:; [l misplny penar rais
Fracision Seloct -4
Text Soloct I % 1 [ Hide paoinier whis typing
Ennia pointar shadow -
0 Heshead e N [[] Show tocation of paintr when | press the CTRL key
oKk | Cancel Appty oKk | Cancel Appty
a Mouse Properties x a Mouse Properties
Eutions  Poniors  Pomior Options Whee!  Hardwara Euticns  Poiniors  Pomior Options Wheal  Hardwars
WVertical Scraling Dvvices:
& Fioll the wheal o natch 1o scrolt Name Typa
F = HID-compliant mouss Mica and otfwr ...
) The folowing puembes of hnes o1 v = Logilech USE WhealMouse Mico and other ...
il & Synaptics SMBus TouchPad Mice and other ..
(7 Oma screen st a tima
Davico Propertios.
Hatizontal Scrofing Manutacturer.  Microsoll
. Tih the whoo! 12 scroll the foliowing number of Location: Synaptics HID-Compliant Touch pad Davica
J characters at a tima: A it o
Davics status:  This devecs 5 working peopsy.
3 =
oKk | Cancel Apgly oK Cancst

2 - 6 Mouse Properties Control Panel
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Mouse & Clickpad Devices a

Y ou can configure the functions from the Mouse or Touchpad control panels in De-
vices in the Settings control panel as follows.
1. Click the Settings item in the Start Menu (or All Settings in the Action Center).

2. Click Devices.
3. Click Mouse or Touchpad.

Windows Settings < Settings
tm Home
System S0 Devices Phane
el — L] Find a setting .
Figure2-5
) Network st = s Devices Windows Settings
..... soisal defauls, aptions > Mouse/Touchpad
- B rccu o R o ® v . Bluetooth & other
(lp Esseof Access ,/O Search EI Privacy WE’
<! 0 Mouse J
A Ypdate & Security
B Touchpad

Mouse & Clickpad Devices 2 - 7
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Mouse Settings
You can select the primary mouse button and scrolling options and access Mouse
Properties from Additional mouse options.

<= Settings —
@ Home Mouse
Find a setting yo | Select your primary button
Left
Devices =

Cursor speed

E@ Bluetooth & other devices —.

|£:| Printers & scanners
. Roll the mouse wheel to scroll
Figure2-6 : :
. . Multiple lines at a time
Windows Settings | O wmouse L i |
Mouse ) )
B2 Touchpad Choose how many lines to scroll each time

_'.,

Scroll inactive windows when | hover over them

@ on

Typing
cf* Pen & Windows Ink

@ AutoPlay

f uss Related settings

Adjust mouse & cursor size

I O G SO S

.|
2 - 8 Mouse & Clickpad Devices
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Touchpad Settings
You can disable the Touchpad by clicking the Touchpad button to turn it off.

You can set the system to automatically disable the internal Touchpad when an ex-
ternal USB point device (e.g a USB mouse) is attached. Click “Leave touchpad on
when a mouse is connected” to off.

@ Home Touchpad
l Find a setting o l Your PC has a precision louchpad.
Devices Touchpad

@ o

i .
& Bluetooth & other devices Leave touchpad on when a mouse is connected

ﬁ] Printers & scanners

Change the cursor speed FI gure 2 _ 7
WL Windows Settings
E  Touchpad TOUChpad
it the
B Typing '
o Pen & Windows Ink Touchpad sensitivity

Medium sensitivity

(®  AutoPlay
A uss Tap with a single finger to single-click
Tap with two fingers to right-click

E Tap twice and drag to multi-select

.|
Mouse & Clickpad Devices 2 - 9
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Touchapd Taps

D The Touchpad Sensitivity feature helps prevent recognizing taps on the pad by ac-
cident, by recognizing when your palm is resting on it or brushing its surface while
you are typing.

Click in the check box to enable/disable the different gestures or taps on the surface
of the pad to perform specific actions to manipulate documents, objects and applica-
tions.

Touchpad sensitivity
1 Muost sensitive

Medium sensitivity v |=———

L

High sensitivity

Figure2-8 : o
Windows Settings Tap with a single finger to single-click ETEREEAE

Touchpad wg
Sensitivity & Taps Low sensitivity

Tap with two fingers to right-click
Tap twice and drag to multi-select

Press the lower right corner of the touchpad to right-click

2 - 10 Mouse & Clickpad Devices
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Touchapd Scroll and Zoom
Click to enable/disable the two finger scrolling and pinch zooming gesture.

Scroll and zoom

Figure2-9
Drag two fingers to scroll I Scro" and Zoom/
\ -
Scrolling direction < ~\\ \J q Scrolling Gesture
| A\ %
Vo \

Down motion scrollsup ~

Pinch to zoom

The two-finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

The two-finger pinch to zoom gesture can be used to perform the same function as
a scroll wheel in Windows applications that support CTRL + scroll wheel zoom
functionality. Place two fingers on the pad (for best results use the tips of the fingers)
and slide them apart to zoom in, or closer together to zoom out.

|
| Figure2- 10
\ ‘ Zooming Gesture

\ \
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The three-finger and four-finger swipes and taps can be configured for a number
of different functions. Select the appropriate function from the drop-down menu.

Three-finger gestures :
Nothing

Swipes
Switch apps and show desktop

Switch apps and show desktop
) Switch desktops and show desktop

FI gure 2 - 11 T Muttitasking view Change audio and volume
Three-Finger .
Gestures b o deskg Nothing
(Swipes & Taps) & Switchapps Launch Windows Search
Action Center ‘
- Switch apps

Play/pause (\m
Taps g
[ | Middle mouse button ] |

Launch Windows Search g“\
'}

Four-finger gestures .
Nathing

Swipes

r 1 Switch apps and show desktop
Switch desktops and show desktop

Switch desktops and show desktop

T Muititasking view Change audio and volume
. 4 Show desktop
Figure2-12 Nothing
Four-Finger € Switch desktops Search with Cortana
Gestures Action Center
=» Switch desktops

(SWipeS & TaPS) Taps Play/pause

Action Center ~ Middle mouse button
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The following is an overview of some of the main gestures you can use with your
Touchpad, however these can be configured from the Touchpad menus.
1-Finger 2-Finger 3-Finger 4-Finger
Left Click Invoke Invoke
(o)i(e ight Click ()l(=)(s T ; :
= Double-Click Right Clic DU Cortana Action Center F|gure 2-13
Touchpad
Gesture Examples
Maiin 1 " 5
-—t.I]‘:-—- Eﬂ:::)r ~(;)‘J[¥~ Scroll / Pan --114'_\‘;}--- Multitasking
b < R 111 Gestures

o ;
O— | Tap + Slide o Pinch / Zoom
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4

Volume Adjustment

The sound volume level
can be clicking using the
volume control icon

in the notification area
of the taskbar.

Figure2- 14
Realtek Audio
Console
(Windows Start
Menu)

Realtek Audio Console

You can configure the audio options on your computer from the Sound - control
panel in Windows, or from the Realtek Audio Console Windows Start menu.
Make sure you have installed the driver and checked the Microsoft Store for
updates (see “Audio” on page 4 - 9). The volume may also be adjusted by means
of the volume icon in the taskbar or the audio slider in the Settings menu (see
sidebar).

.‘ Heerle Explore

) Photo Editor | Polarr

Photos ﬁ

Microsoft Store Photo Editor |...

()
.

Settings m Paint 3D

. Realtek Audio Console

New

Skype
Snip & Sketch

Sticky Notes

£ flype here to search
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Realtek Audio Console - Main

You can adjust the Speaker and Microphone levels by using the sliders in the Re-
altek Audio Console Main window.

fealtek Audio Consola

- o x
- A Main Playback Devices
| Speakers = Flgure 2 = 15
— Owe & Realtek Audio
4 Speakers Console
eline; Bisices Recording Devices (Ma|n)
\} Mismphsuu-ﬂ Microphone & Q

Q Device advanced settings

o Information
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Realtek Audio Console - Speakers
Click Speakers to access controls for the format and speaker balance etc.

Figure2 - 16
Realtek Audio
Console
(Speakers)

2 - 16 Realtek Audio Console

Fealte: husko Conacie

W nan

@ Speakers

& Microphone

L Device advanced settings

@ intormation

Main Volume

T

n &« om

Default Format
Sefect the sample rate and bit depth 1o be used when running in shaned mode.

ABOOOHE 24Bits Reset

Speaker Configuration

Full-range Speakers

[ Front lef and right

BB

»>



Realtek Audio Console - Microphone

Click Microphone to access advanced controls for recording on the microphone.
Adjust the recording Main Volume level to around 60, to obtain the optimum re-

cording quality. .

Realtek Audio Consale

| A Main

} ) Speakers

‘ & Micophone

L Device advanced settings

@ information

Main Volume

_——— 8 [ mute

Microphone Boost

[

| +20 dB

Microphone Effects

Molse §U|\]]fl’ﬂ§i0|\ reduces ambient stationary noises, i.e, Notebook PC fan, air condition fan nolse, thus EMProving
@D off

AEC removes the acoustic echo coupled into the microphones from the loudspeaker output thru air

@D o

Default Format
Select the sample rate and bit depth to be used when running in shared mode.

| 48000Hz 168its Reset

Features & Components

Figure2- 17
Realtek Audio
Console
(Microphone)
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Features & Components

p Realtek Audio Console - Device Advanced Settings

Device Advanced Settings allows for further configuration of the Connector and

Recording Device.
Realtek Audio Console

W Main

Playback Devices
) Speakers

Recording Devices

F|gure 2-18 & Microphone
Realtek Audio
Console - Device
Advanced Settings

£} Device advanced settings

© nformation

Connector Settings

Enable Jack detection when device is plugged in

@ on

Connector Retasking
ANALOG

Headset

Recording Device
@ Tie up same type of input jacks, i.e, line-in or microphone, as an input device.

O Separate all input jacks as independent input devices.

2 - 18 Realtek Audio Console



Power Management

Chapter 3: Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- || POWer  management
functions will vary slight-

agement conserves power by controlling individual components of the computer ¥ dkpEsle @n e
(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.

* The Power Sources

* Turning On the Computer

* Power Plans

» Power-Saving States

» Configuring the Power Buttons
* Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1



Power Management

4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del

key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.
1.  When first setting up the computer use the following procedure (as to safe-

guard the computer during shipping, the battery will be locked to not power the
system until first connected to the AC/DC adapter and initially set up as below):

+ Attach the AC/DC adapter cord to the DC-In jack on the right of the computer, then plug the AC
power cord into an outlet, and connect the AC power cord to the AC/DC adapter and the battery
will now be unlocked.

2. Raise the lid/LCD to a comfortable viewing angle.
3. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “ Battery FAQ” on page 3 - 22).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 17.

. |
3 - 2 The Power Sources



Power Management

Thunderbolt 4 Combo Port with Power Delivery (DC-In)

The Thunderbolt 4 Combo Port with Power Delivery (DC-In) allows you to use a

third party AC/DC adapter/laptop power bank plugged into the port as a power sup-
ply.

If you are using a power bank make sure that it complies with the USB-C PD (Power

Delivery) standard specification rated at 20V/65W - 20V/100W.

If you are using a third party AC/DC adapter, the rating of the adapter must be at
least 20Volts, 3.25A (65 Watts) and it should be appropriately certified.

The Power Sources 3 - 3
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Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

2NZ
Z &

Power Button

Note that for the power . )
Sl leneritieie i o/- @ When the computer is on, you can use the power button as a Stand by/Hibernate/

LCD must be open. Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS’s “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 10 for details).

3 - 4 Turning On the Computer



Shutting the Computer Down

Power Management

Note that you should always shut your computer down by choosing the Shut down
command as this will help prevent hard disk or system problems. Use the Power

item in the Start Menu and select Shut down.

You can also use the context menu (right-click the Start Menu &g icon or press the
Windows logo =® + X key combination) to Sign out, Sleep, Hibernate, Shut

um
down, and Restart.

If you want to add Hibernate/Sleep to the Power Menu see “ Adding Hibernate/

Sleep (Modern Standby) to the Power Menu” on page 3 - 11.

Device Manager

Metwork Connections
Ea 3D Viewer

A

Disk Management

Computer Management
Q7 Alarms & Clock

S

E Calculator

Windows PowerShell (Admin)
Calendar Task Manager

Settings
Sleep

File Explorer
Hibernate

Search

Run

Shut down or sign out

Deskto
~" Type here to search SRERE

Figure3-1
Shut Down/Restart

Hibernate
Shut down

Restart

Shutting the Computer Down 3 - 5
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~ 7 Power Plans

Resuming
Operation

create a new one.
See Table3 - 1, on
page 3 - 12 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-

Change settings for the plan: Balanced
der to protect your data.

Choose the sleep and display settings that you want your computer to use.

i On battery ,’ Plugged in
FI gure 3 - 2 L Tumn off the display: 4 minutes ~ 10 minutes
Power Plan ’ Put the computer to sleep: |4 minutes ~ 10 minutes

Advanced Settings

Change advanced power settings

The computer can be configured to conserve power by means of power plans (Con-
trol Panel > Power Options). You can use (or modify) an existing power plan, or

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

| > All Control Panel Items > Power Options > Edit Plan Settings v (]

Save changes

S| 3@ Power Options ? *

Advanced sesings

X Select the power plan that you want to customize,
f and then chaase settings that reflect how you want
your camputer 1o manage power.

Balanced [Active] ik

Balanced T
= Require a password on wakeup
On banery: ves -
Plucpeped in: Y
il Hard disk
# Internat Explarar
+ Deikrop background settings
il Wireless Adapter Settings

5 Sleep
+ USB settings

i Pawer buttons and lid

e e i

Bestore pian defaults

: Cancal Appily

3 - 6 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

The Balanced power plan is the default, however you can click Create a power
plan to create a customized power plan.

| W Power Opeons = a x
| =+ = 1+ W Conrol Panel * All Control Pared ltems * Power Options v € o
L]
Choose or customize a power plan
A power plan is a collection of hardware and system settings (1ike display brightness, sieep, etc.) that
manBges how your computer uses power. Te me move sbout power ol
Selecied plan
Balanced
Automatically balances performance with energy consumption on capable hardware.
|,“ Create a Power Plan Power PlanS
«~ i, ‘j * Controf Panel * All Controd Panel ltems * Power Options * Create a Power Plan o (¥}
| File Edit View Tools
Create a power plan
Start with an existing plan and give it a name.
Balanced
| Automatically balances performance with energy consumgption on capable hardware,
|
Plan name:
; My Custom Plan 1
|
| Next Cancel

Power Plans 3 - 7
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Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Windows 10 uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep (Modern Standby)

This system supports Sleep mode as Modern Standby. In this case the system will
continue to download mail, Windows updates, calendar updates and even VolP calls
via a Windows Store app, even when the system is in Sleep (Modern Standby)
mode, in much the same way as a smartphone.

In Sleep (Modern Standby) all of your work, settings and preferences are saved to
memory before the system sleeps. When you are not using your computer for a cer-
tain length of time, which you specify in the operating system, it will enter Sleep
(Modern Standby) to save power.

The PC wakes from Sleep (Modern Standby) within seconds and will return you
to where you last left off (what was on your desktop) without reopening the applica-
tion(s) and file(s) you last used.

If your mobile PC in Sleep (Modern Standby) is running on battery power the sys-
tem will use only a minimum amount of power. After an extended period the system
will save all the information to the HDD/SSD and shut the computer down before
the battery becomes depleted. To add Sleep (Modern Standby) to the Power Menu
see page 3- 11.

3 - 8 Power-Saving States



Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hibernate to the
Power Menu see page 3 - 11.

Shut down

You should Shut down the computer if you plan to install new hardware, plan to be
away from the computer for several days, or you do not need it to wake up and run
a scheduled task. Returning to full operation from Shut down takes longer than from
Sleep or Hibernate.

Task Manager

Settings Sign out

D Sleep

File Bxplorer Slee
© Hibemate E ey

" Shut down Search Hibernate

) Restart e Run Shut down

Shut down or sign out Restart

Deskiop

Power-Saving States 3 - 9
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Figure3-4
Power Button &
Start Menu Power
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Configuring the Power Buttons
The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the

4

Password . . .
Protection computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.
It is recommended that e ———
you enable a password : _ _ -
- Wake up |n order to - « 4 @ “ All Control Panel ltems * Power Options » Systemn Settings w U Search Contral Panel F-l
prOteCt your data. Define power buttons and turn on password protection
Chaose the power settings that you want for your computer. The changes you make to the settings on this

However you can dis- ;g.e i Y
able this setting from the - | dld
Power Options menu Power and sleep buttons and lid settings "
by clicking Require a ) oty s
paSSWO rd on Wakeu p @ ‘When | press the power button:  Sleep , Sheep s
in the left menu, and se-
|ect|ng the Optlons (C|ICk @ Whan | press the sleep button: Sleep » Sheep s
Change Settlngs that ,_' ‘Whaen | close the lid: Sleap ¥ |Sleap o

are currently unavail-
able). Shutdown settings

Turn on fast startup (recommended)
This heips start your PC faster after shutdown, Restart isn't affected. Learn Maore

Sleep
Figure3-5 ShonisForw
H ibernate
Power Options Shew in Power mena,
Define Power Lock

Show in account picture menu

Buttons

Cancel

.|
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Adding Hibernate/Sleep (Modern Standby) to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

Go to the Power Options (Hardware and Sound) control panel.

Click “Change settings that are currently unavailable” & changesetings thet ar= currently unavailsble .
Click Choose what the power buttons do.

Click to put a check in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

agroN=

Define power buttons and turn on password protection

Choose the power setting
. ¥ 1o all of your po

hat vou want for your computer. The changes you make to the settings on this

Shutdown settings

i On battery A P T
urn on fast startup ( .
@ ‘When | press the power button;  Sleep w Sheep £ FI gur e 3 - 6
This helps start your PC Power Options
@ When | press the sleep button:  Sleep ~ | | Sleep 5' e E‘p B ttDefi neSPhOY(ier
'_" When | close the lid; Sleep v | | Sleop = uttons - utdown
Show in Power menu. Settings
Shutdown settings
Turn on fast startup (recommended) thErnatE
This heips start your PC faster after shutdown, Restart isn't affect; E:
Steep Show in Power menu.
Show in Power menu,
Hibernate
Show in I:u\-wl men La c k
I";:;\:r in account picture menu 5 h Dw in a [ [ O u ﬂt p i [tu rl
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,

E or in some cases pressing the sleep button (Fn + F12 key combo).
Power Status Icon /() Color To Resume
Table3-1
Resuming Power Off Off Press the Power Button
Operation Press the Power Button
Sleep Blinking G
(Modern Standby) Inking tsreen Press the Sleep Button (Fn + F12 Key
Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Clickpad
Closing the Lid Power Button
If you have chosen to When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
send the computer to hot key button when it is pressed for less than 4 seconds (pressing and holding the power
Sleep (Modern Stand- button for longer than this will force the computer to shut down).
by) when the lid is
closed, raising the lid

will wake the system up.

3 - 12 Configuring the Power Buttons
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Ctrl + Alt + Delete Key Combination

You can use the CTRL + ALT + DEL key combination from almost any of the Win-
dows 10 interfaces/Apps to bring up a full-screen displaying Lock, Switch User,
Sign out, Change a password and Task Manager options. If you click the Power
icon in the lower right corner of the screen a power management option menu ap-
pears to display Sleep (Modern Standby), Shut down, and Restart.

Figure3-7
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

Configuring the Power Buttons 3 - 13
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Settings Menu Power Controls

The Settings item in the Start Menu (or via the Action Center) gives you access to
a number of power settings control panels which enable you to quickly adjust power
options. Click System to access the menu including the power option settings.

Settings

Windows Settings

Settings

System Devices |:

Display, sound, notifications, Bluetooth, printers, mouse

power

Figure3-8

o—
Network & Internet j Personalization a—
. | | o—
sett'"gs @ Wi-Fi, airplane mode, VPN Background, lock screen, colors Ll
R Accounts @.-.. Time & Language @
Your accounts, email, sync, A_? Speech, region, date
work, family

(:1:’4 Ease of Access O Cortana ;

Narrator, magnifier, high Cortana language
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Battery Saver

Battery in Settings will display the battery level, and by clicking Battery usage by
app you can see the current state of battery usage by application etc. The Battery
saver can be level can be adjusted to be turned on if the battery level falls below a
certain level to limit background activity and push notifications.

< Settings s o x
& Home Battery
1 . |
9%
System
0 Display
Battery saver
91 Soursd
To get mone from your battery when it's running bow, limit natifications.
[J Matifications & actions and background activity.
@ o
&) Focus assist
{5 Power & sleep Tum battery saver on automatically at Flgure 3 = 10
N Settings > Battery >
O Batte '
" Battery Saver
Lower screen brightness while in battery saver
= Storage
0F  Tablet
i Motttk Battery usage per app
e period: | 24 b -
51 Projocting to this PC Tirme period: OUrs
Sattings 6%
¥ Shared experiences Manag window
e

Settings Menu Power Controls 3 - 15
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Power & Sleep
Power & sleep gives you quick access to Screen and Sleep settings. Click Addi-
tional power settings to go to the main power options control panel.

+ Seftings. =} =
@ Home Power & sleep
[ Find 2 setting | Screen
System ©n battery power, turn off after
3 Display
When plugged in, turn off after
a4 Sound | X |
5 minutes v
[ Notifications & actions
2 Focus assist Sleep
On battery power, PC goes to sleep after
I ™ Power & sleep
10 minutes e
=2 Battery

When plugged in, PC goes to sleep after

Flgure 3 = 11 = Storage 15 minutes .

Settings > Power & [@ Tablet mode
Sleep

B Multitasking

Save energy and battery life

Projecting to this PC Make your battery last longer by choosing shorter times for screen and sleep settings

% Shared experiences

Related settings

M Clipboard

Additional power settings

3% Remote Desktop
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Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3-3o0npage3-7).

Click the battery icon in the notification area to see the current battery level and
charge status (you can also click Power & sleep settings to access the Settings
menu to quickly adjust power settings).

= 3/%

Select the power plan ml, s want 10 customize.

‘? and then M.\:seutm: that

MANBGE POWEr

eflect how you want
your eomputer 1

Balanced [Active]

Power mode (on battery): Battery saver

'—

Battery settings

Power Management

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure3-12
Battery Icon
(Notification Area) &
Battery Advanced
Settings
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Power Slider Settings
4

Battery Saver Battery Saver Better Battery

Better Best
Performance Performance

Note that some Win-
dows features and back-
ground applications may
behave differently, or
may be blocked, when
the system is in Battery
Saver mode (check with For DC Only For AC & DC
Microsoft for details).

Slightly Favors

Favors Performance
Performance Over

Lowest Power Setting Lower Power than

Default Settings Over Power
Power
Table3-2
. Windows Features
Power Slider Throttled & Screen Default Position
Settings & Notes Brightness Reduced

Auto Enabled at 20% of
Battery Capacity

.|
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Conserving Battery Power

» Use a power plan that conserves power (e.g Power saver), however note that Z
this may have an affect on computer performance. Windows Mobility
Center

* Lower the brightness level of the LCD display. The system will decrease LCD

brightness slightly to save power when it is not powered by the AC/DC adapter. || 1he Windows Mobility

Center control panel
* Reduce the amount of time before the display is turned off. provides an easy point
of access for information

* Close wireless, Bluetooth, modem or communication applications when they are 510 By S, PO

not being used. plans used and wireless
 Disconnect/remove any unnecessary external devices e.g. USB devices, deniee siEins ci.
ExpressCards etc.
8 Windows Mobility Center = X
1 { Display o Fully charged No display
E—.m brightness . W [ Mute ﬁﬂ (100%) = connected
i g S
Brightness Volume Battery Status External Display
@ ::rts::;H'ss @y Not presenting _Flgure 3 - 13
' Windows Mobility
i Center
Sync settings Turn on
(Control Panel)
Sync Center Presentation Settings

@
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself as the removal of the
bottom cover may violate the terms of your warranty.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 22 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. Refer to “LED Indica-
tors’ on page 1 - 8 for information on the battery charge status, and to “ Battery
FAQ” on page 3 - 22 for more information on how to maintain and properly re-
charge the battery pack.
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Proper handling of the Battery Pack

* DO NOT disassemble the battery pack under any circumstances ik
* DO NOT expose the battery to fire or high temperatures, it may explode Caution

* DO NOT connect the metal terminals (+, -) to each other D o
anger of explosion if

battery is incorrectly re-
placed.

AN
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ
How do I completely discharge the battery?

3 Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

.0
Figure3- 14
Change Plan
Settings / Change
Advanced Power
Settings 3 it Plan Setvims ‘ . .— 0o x®

4 o AllControlPanel Rems © Power Dptions + £di Plan Sestings

Change zettings far the plan: Discharge Battery

CReese the sieep and drplay Sefengs that yeu want yewr coenpuer te use.

' G battery 29 Puggrdm

W Put the computer 1o deeps [ Never v|  Mever
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4.
5.

Scroll down to Battery and click + to expand the battery options.
Choose the options below (click Yes if a warning appears):

3 Power Options ?
Advanced settings

\Gm Select the power plan that you want to customize, and
@ then choose settings that reflect how you want your
computer to manage power.

Discharge Battery [Active] v

X

= Low battery level
On battery: 0%
Plugged in: 0%

= Critical battery level
On battery: 1%
Plugged in: 1%

= Low battery notification
On battery: On
Plugged in: On

1 1w hatbans artinn

Restore plan defaults

Cared | | oy

Low battery level = 0%

Critical battery level = 1%

Low battery action = Do Nothing
Reserve Battery Level = 0%

Power Management

Figure3- 15
Power Options
Advanced Settings -
Battery

Battery Information 3 - 23



Power Management

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

3 - 24 Battery Information



Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

You will need to attach an external optical CD/DVD device drive to install the
drivers from the Device Drivers & Utilities + User’s Manual disc. The disc con-
tains the drivers and utilities necessary for the proper operation of the computer.
Table4- 1, on page 4 - 4 lists what you need to install and it is very important that
the drivers are installed by the method outlined in this chapter, and in the order
indicated. Note that the information on the following pages is for Windows 10 (64-
bit) only.

Module Driver Installation
The procedures for installing drivers for the Wireless LAN and Combination Blue-
tooth & WLAN modules are provided in “Modules & Options’ on page6 - 1.

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’'s Manual disc into an attached DVD drive.

Click the message “Tap to choose what happens with this disc.”

Click Run autorun.exe.

Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

PN =

&) Drivers Installer = x

Figure 4 - 1 - Drivers Installer Screen 1
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order)
which is the same as that listed in the Drivers Installer menu below.

Click to select the driver you wish to install, (you should note down the drivers as you install them).

Follow the instructions for each individual driver installation procedure as listed on the following pages.

No

) Drivers Installer _ %
: S 5

Please follow steps from top to
bottom in order to install drivers.

Figure4 - 2 - Install Drivers
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o) 21 Dri\ll:rs (.64'bit) ST Page # Win 10 Drivers (64-bit) Other / Options Page #
equired

Chipset Page 4 -7 | SATA Mode Setup (Optane™, RAID or AHCI) Page 6 - 2
Serial 10 Page 4 -7 | Fingerprint Reader Module Page 6 - 19
Video (Intel VGA) Page 4 -7 Bluetooth Page 6 - 23
LAN Page 4 -8 Intel® Speed Shift Technology Driver Page 6 - 29
CardReader Page 4 - 8 Intel® Rapid Storage Technology Page 6 - 30
Intel® HID Filter Driver Page 4 -8 PC Camera Module (No driver required) Page 6 - 46
Control Center Page 4 - 8 IR Camera (No driver required) Page 6 - 52
MEI Driver Page 4 -8 | Trusted Platform Module (No driver required) Page 6 - 57
Intel® Dynamic Platform Driver Page 4-8 | All driversprovided are for Windows 10 (64-bit).
Thunderbolt Driver Page 4-9 | Note that you need to install both the WLAN & Bluetooth
rodio Page4-9 driversfor the WLAN & Bluetooth Combo modules.

Table 4 - 1 - Driver Installation

. |
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Manual Driver Installation

Click Browse CD/DVD (button) in the DriversInstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Check for updates (Settings > Update & security >
Check for updates) in order to get all the latest secu-
rity updates etc. (all updates will include the latest hot-
fixes from Microsoft). See “Windows Update” on
page 4 - 10 for instructions.

Drivers & Utilities

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs icon (Programs > Unin-
stall a program). Click to select the driver (if it is not
listed see below) and click Uninstall, and then follow
the on screen prompts (it may be necessary to restart
the computer). Reinstall the driver as outlined in this
chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go to the Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

Driver Installation 4 - 5
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User Account Control

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4 - 6 Driver Installation

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.



Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click 1.Install Chipset Driver > Yes.

2. Click Next > Accept > Install.

3. Click Restart Now to restart the computer.

Serial 10

1. Click 2.Install Serial I/O Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Next > Next.

5. Click Finish.

Video (Intel VGA)

1. Click 3.Install VGA Driver > Yes.

2. Click Begin Installation.

3. Click the check box to agree to the terms and

conditions and click Next.
4. Click Start.

Drivers & Utilities

5. Click Reboot now to restart the computer.

6. Intel Graphics Command Center will down-
load but you will need to have a working inter-
net connection.

7. Click the Start menu in Windows to access the
Microsoft Store App tile under Explore.

8. Click the Sign in icon &, and select Down-
loads and updates.

9. Click Check for Updates.

10. A list of apps being downloaded will pop-up.

11. To prioritize the driver you can click Pause all
to pause the download queue.

12. Click on Intel Graphics Command Center
and click on the resume icon O to download
the driver.

13. When finished the Intel Graphics Command
Center will appear in the Windows Start
menu.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
eo settings to the highest resolution.
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LAN Control Center

Note: If the computer entersa deep sleep modeduring 1. Click 7.Install Ctrl Center Driver > Yes.
installation, you will be prompted to pluginanetwork 2. Click Next > Install.

cable, and click OK, to continue installation. If anet- 3. Click Finish > Finish to restart the computer.
work cable is not available, restart the systemand re-

install the LAN driver. MEI Driver

1. Click 4.Install LAN Driver > Yes. 1. Click 8.Install MEI Driver > Yes.

2. Click Next > Install. 2. Click Next.

3. Click Finish. 3. Click the check box to accept the license and
then click Next.

CardReader 4. Click Next.

1. Click 5.Install Cardreader Driver > Yes. 5. Click Finish.

2. Click Finish.
Intel® Dynamic Platform Driver

Intel® HID Filter Driver I. Click 9.Install DPTF Driver > Yes.

1. Clle 6.Install HID Filter Driver > Yes. 2. Click OK > OK (make sure you click all the
2. Click Next. OK messages which pop-up) to complete the
3. Click Yes to accept the license. installation.

4. Click Next.

5. Click Finish to restart the computer.
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Thunderbolt Driver
1. Click 10.Install Thunderbolt Driver > Yes.
2. Click OK to complete the installation.

Audio

1. Click 11.Install Audio Driver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

4. Realtek Audio Control Panel will download
but you will need to have a working internet
connection.

5. Click the Start menu in Windows to access the
Microsoft Store App tile under Explore.

6. Click the Sign in icon R, and select Down-
loads and updates.

7. Click Check for Updates.

A list of apps being downloaded will pop-up.

9. To prioritize the Realtek audio driver you can
click Pause all to pause the download queue.

10. Click on Realtek Audio Control and click on
the resume icon OO to download the driver.

S

Drivers & Utilities

11. When just installed the Realtek Audio Con-
sole will appear in the Windows Start menu.

After installing the audio driver the system will not re-
turn to the Drivers Installer screen. To install any of
the optional drivers, eject the Device Drivers & Utili-
ties+ User’s Manual disc and then reinsert it (or dou-
ble-click the disc icon in My Computer), and click
Option Drivers (button) to access the optional driver
menu.
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4
Windows Update

After installing all the drivers make sure you enable
Check for updates in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

Click the Start Menu and select the Settings item.
Click Update & Security.

Click Check for updates (Windows Update).

The computer will now check for updates (you
need to be connected to the internet).

The system will install any available updates.

Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 4 for
the driver installation procedures for any modules in-
cluded in your purchase option.

&) Drivers Installer = X
S 0

| ‘“ "l\ilpbile Cc}'z_mnulin .

Please follow steps from top to

bottom in order to install Option
CUTSEIWIANDRETT™ drivers.

=
Jnstall Fingerprant DAver
S

Figure 4 - 3 - Optional Drivers Installer Screen

Note that you need to install both the WLAN & Blue-
tooth drivers for the WLAN & Bluetooth Combo
modules.
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BIOS Utilities

Chapter 5: BIOS Utilities "

0ve rview BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
If your computer has never been set up, or you are making important changes to the BRI RESERTElIE S RS
system (e.g. hard disk setup), then you should review this chapter first and note the JHEISES
original settings found in BIOS. Even if you are a beginner, keep a record of the set- .

. .. ) ; BIOS versions are sub-
tings you find and any changes you make. This information could be useful if your ject to constant change

system ever needs servicing. and revision, therefore
your computer’'s actual

There is one general rule: Don’t make any changes unless you are sure of what you  Jsisisi ENE ey
slightly different from

aredoing. Many of the settings are required by the system, and changing them could ~JE¥SSES pictured on these
cause it to become unstable or worse. If you have any doubts, consult your service pages.
representative.

This chapter gives a brief introduction to the computer’s built-in software BIOS
(Basic Input/Output System).

To enter BIOS, turn on the computer and press F2 as the system “Boots up”.

. |
Overview 5 - 1



BIOS Utilities
The Insyde BIOS Utility

Each time you turn on the computer the system takes a few seconds to conduct a in-
cluding a quick test of the on-board RAM (memory).

BIOS Settings
Warning

Incorrect settings can As the bpot process proceeds, the computer will tell you if tl?ere'is apything wrong.
cause your system to If there is a problem that prevents the system from booting, it will display a system

malfunction. To correct summary and prompt you to run the BIOS setup.
mistakes, return to BIOS

Sl BRI FLE Rl [f there are no problems the system will load the operating system. Once that starts,
Defaults (press F9). you can’t get into Bl OS without rebooting.

The Setup BIOS Utility tells the system how to configure itself by translating in-
structions from the operating system, and other software, into instructions that the

Z computer hardware understands. manage basic features, identify installed devices
BIOS Menus and subsystems (e.g. port configuration).

q \ A/
The menus shown in 7&(
this section are for ref- . . .
erence only. Your com- BIOS and Resuming From Hibernation
puters  menus  will
indicate the configura-
tion appropriate for your
model and options.

When the system resumes from Hibernation the option will be available to press F2 to
enter the BIOS. In this case do not make any changes to the BIOS settings as this may
result in system errors.

If you wish to change the BIOS settings, restart the system and press F2 to enter the BIOS
to make and save any changes required.
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BIOS Utilities
Updating the BIOS / CPU

If you need to update the BIOS please contact your distributor or supplier to obtain
the latest version.

After using the utility to update the BIOS (or if the CPU has been changed) you will
need to press F2 at Boot to enter the BIOS, and then press F9 to load the BIOS
defaults, and then press F10 to save and exit the settings.

After the system restarts you should press F2 to enter the BIOS again and reset the
BIOS settings to your preferences, and then save the final settings.

Updating the BIOS/CPU 5 - 3



BIOS Utilities
UEFI Boot

UEFI (Unified Extensible Firmware Interface) is an advanced firmware standard
supporting fast startup.

With UEFI Boot prompts at boot to press F2 (to access the BIOS) or F7 (to access
Boot options) will not appear. However you can still press F2 to enter the setup, or
F7 to choose the preferred boot device, if you press the key immediately the system
boots up.

To enter BIOS, turn on the computer and press F2 as the system “Boots up”.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The BIOS main menu will appear. To see the
boot options press F7 and choose your preferred boot device.

.|
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Insyde BIOS Start Screen

On accessing the BIOS you will be presented with the Start Screen with 5 menu
icons, date and time information, CPU temperature information and navigation and
Help icons at the bottom of the screen.

You can use the Clickpad, an attached mouse, or the cursor/arrow keys to navigate
the menus and press Enter to access the submenu.

insyde

iNnsyde

Figure5-1
Insyde BIOS Start
Screen
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Insyde BIOS Start Screen Options:

» Continue: Press Enter here or click Continue to carry on with the boot process
and load the operating system.

* Boot Manager: Press Enter here or click Boot Manager to access the Boot
Manager utility.

* Boot From File: Press Enter here or click Boot From File to select a file or
device to Boot from.

* Administer Secure Boot: Press Enter here or click Administer Secure Boot to
proceed with a Secure Boot process. This will take you to the Secure Boot
screen which allows you to manage secure boot settings.

» Setup Utility: Press Enter here or click Setup Utility to access the BIOS settings
in the Setup Utility.

Note to return to the Start Screen from any of the submenus press the EsC key.

.|
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Boot Manager

lnsyde . insyde
) Figure5-2

Boot Manager

ot Manager

SN
ALK

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-

— . ' . ject to constant change
When you turn the computer on it will look for an operating system from the devices Jand revision. therefogre

listed in this menu, and in this priority order. If it cannot find the operating system BRI = F|
on that device, it will try to load it from the next device in the order specified in the FEEEEUERRUEVERCIeEe S

Boot Option Menu slightly ~ different from
) those pictured on these
Press Enter to access the menu, use the arrow keys to move up and down the menu, JREEEEES

and press Enter to select a device.
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Boot From File / File Explorer

1r’15yde . insyde

E.Ox0)/Sata(Ox1.0...

\OxFFFF,0x0)HD(... NO VOLUME LABEL.
[PciRoot(0Ox0)/Pc r(G(E
x1.0xFFFF.0x0)HD(...

Ox0)/HD(1.GPT.425845
ES-B762-45D4-A4AE-A

E4C1996B346,0x800.0
%x32000)]

Figure5-3
Boot From File
(File Explorer)

If you need to boot from a file (e.g. on a USB flash drive) then access this menu and
use the cursor keys to select the device or file (you can press Enter to explore for a
file on an attached device).
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Administer Secure Boot
Nsyde

Administer Secure Boot

Unlocked
Disabled
NO

BIOS Utilities

Erase all Secure Boot
Settings

Enable this option will erase all
Secure Boot Settings. This action
will clear four variables PK. KEK,

Boot

Figure5-4

Administer Secure

db, and dbx.

isted for execution
Disabled >

Disabled =

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. You can select a trusted UEFT file to execute the BIOS,
make sure that you Enforce Secure Boot, Erase all Secure Boot Settings or Restore
the Factory Settings.

. |
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You can also make custom changes to the Key Management database if required by
accessing the advanced secure boot options for Platform Key (PK Options), Key Ex-
change Key (KEK Options), Allowed Signatures Database (DB Options) and For-
bidden Signatures Database (DBX Options).

inSYde' insyde

Administer Secure Boot

DBX Options

EnrolliDelete DBX
Figure5-5
Administer Secure
Boot (Advanced
Secure Boot
Options)

usted for execution

Disabled >
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Setup Utility - Main Menu

insyde' insyde
[(£] Main

Figure5-6
Main (Upper)

|

System Time & System Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @0 = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.
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System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

ME FW Version/ MB Series/ BIOSRevision / KBC/EC firmware Revision/ Mac

Address
This item contains information on the BIOS version and is not user configurable.

Your system’s CPU will be listed in the Main menu e.g. Intel(R) Core(TM)....

.|
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Setup Utility - Advanced Menu

INsyde ‘ _ insyde

[B, Advanced
@ = Advanced Chipset Control
Main » ThunderbaltiTM) Configuration Advanced Chipset

Control
SATA Maode:

Battery Low Alarm Beep: Advanced Chipset Control

Figure5-7

Advanced Menu

Boot

Y @ © 000 © ® @

Advanced Menu
The Advanced menu provides settings for Advanced Chipset Control (see over),
Thunderbolt Configuration, the SATA Mode and Battery Low Alarm Beep.

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enable/disable the Flexicharger, VT-d and UEFI
OS Fast Boot.
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- FlexiCharger (Advanced Menu > Advanced Chipset Control)
ﬂ‘ The sub-menu here allows you to enable/disable the FlexiCharger. The FlexiCharg-
FlexiCharger er may be set to automatically start charging your battery when the battery reaches
Warning a certain capacity level (e.g. you could start the battery charge level at 40%).

WEEREREUEIE DU You can then set the level to stop charging (e.g. 100%), and of course this stop
arger continuously "En-

abled” for a period of
three months or more,
the battery meter's read-
ing accuracy will deteri-

charge level must be higher then the start charge level.

See the sidebar warning for information on running the FlexiCharger for an ex-
tended period as this is not recommended.
orate.

insyde ) insyde

To reset this, set the
FlexiCharger to "Dis-
abled", and then allow
the battery to completely
discharge (see

)

before enabling the
function again.

HD

Figure5- 8
Advanced Chipset
Control >

FlexiCharger ) © 0O Ee ©

5 - 14 Setup Utility - Advanced Menu



BIOS Utilities

VT-d (Advanced Menu > Advanced Chipset Control)

Enable/disable Intel® Virtualization Technology for Directed I/O (VT-d) from
this menu. This extends Intel's Virtualization Technology (VT) by providing hard-
ware assists for a virtualization solution.

UEFI OSFast Boot(Advanced Menu > Advanced Chipset Control)
Use this menu item to enable/disable the Fast Boot option, which when enabled,
helps reduce the time it takes to boot the computer.

Intel(R) Thunderbolt Configuration (Advanced Menu)
You can enable/disable the Intel(R) Thunderbolt port support from this menu (Dis-
crete Thunderbolt(TM) Support).

Security Level (Advanced Menu > Thunderbolt(TM) Configuration)
You can set the security level to No Security, User Authorization, Secure Connect
or Display Port only.

* No Security mode will allow any devices to be connected. In this mode the
connection manager auto connects to any new devices which are plugged in.

*  WIth User Authorization you can set the port to allow only devices with a
Unique ID to connect. If the unique ID is not located then you will be asked
to confirm the connection. The connection manager will request approval from
the host and auto approval may be given based on the unique ID of the connect-
ing device.
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* With Secure Connect you can set a one time saved key only then the host will
write a unique ID to a device to ensure only approved devices can connect.
The connection manager will request approval from the host, and auto approval
is only given if the host challenge to the device is acceptable.

» Setting the port to Display Port only will only allow display devices to con-
nect to the port, and no data connections will be allowed. In this mode only
displays are connected (re-driver or DP tunnel, no PCle tunneling) and no tun-
neling is done for PCle devices.

* USB Docking Only allows you to configure the port to connect to a Thunder-
bolt Docking Station’s USB ports.
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SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operate in AHCI (Advanced Host 4
Controller Interface) mode or in Intel RST Premium With Intel Optane System Intel® Optane ™

Acceleration (for either RAID or Intel® Optane™) mode. Note that your system Intel® Ontane™ is & combi-
can beset up asa RAID OR to support I ntel® Optane™, it cannot be set to support | ation F:,f a compatible

both systems. memory device and Intel
Rapid Technology soft-

The SATA Mode should be set BEFORE installing an operating system, and after | Wware. This combination is
you have backed up all necessary files and data (see sidebar). See “ SATA Mode Set- :ssst'g:neseﬁ;z;ii:_p your
up (Optane™ or AHCI)” on page 6 - 2 for details. Make sure you install the IRST o
driver if you have set the SATA Mode toto Intel RST Premium With Intel Op- gf;;ﬁgtr {: l;;: |;tl;23:o;y:
tane System Acceleration (for Optane or RAID), or to AHCI (see “|RST Driver tem supports this technolo-
Installation” on page 6 - 21). ay-

SATA Mode
Selection

AN
Ik

Intel® Optane™ Supported by IRST Driver

If you have installed the
Windows OS with AHCI,
or Intel RST (Optane/
RAID) mode enabled, DO
NOT disable the set mode
(if you wish to disable the
set mode you will need to
reinstall the Windows OS).

You do not have to set the SATA Mode to Intel RST Premium With Intel Optane Sys-
tem Acceleration if you install the IRST driver, and setup the SATA controller to Premi-
um mode by selecting “Switch System SATA controller to Intel® RST Premium mode
(Recommended).” as part of the driver installation process (see

). DO NOT uninstall the driver and application after selecting
Intel® RST Premium mode.
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If you wish to change your SATA mode to/from AHCI/Intel RST (Optane)/RAID
mode note that doing so may prevent your operating system from booting, and may
require a reinstall of the OS. If you do wish to change the SATA mode then backup
any necessary data on your hard disk(s) as you will need wipe the disks clean in or-
der to prevent system problems.

Intel(R) Rapid Storage Technology (Advanced Menu)

This menu will appear after you have restarted the system, having enabled Intel RST
Premium With Intel Optane System Acceleration, and will list the disks as part of a
RAID or Optane system.

Intel Optane Options

Intel® Optane™ is a combination of a compatible memory device and Intel® Op-
tane™ Memory and Storage Management app. This combination is designed to
speed up your system performance by caching boot data, executables, frequently ac-
cessed data and system page files to an non volatile, low latency Intel® Optane™
SSD.

* Intel® Optane™ Memory Series - A single Intel® Optane™ SSD automati-
cally configured as a single volume disk, designed to speed up your system
without any data storage options.
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Clearing Intel Optane

If you need to clear Intel Optane Memory data then follow the process below, how- e
ever note you will need to back up your system first as the procedure will result Intel® Optane™
in the system being required to be reinstalled and data and files will be lost in the Memory Series
Process. Intel® Optane™ Mem-
1. Go to the BIOS and select Bios setup > Advanced > Intel Rapid Storage Technol- ory Series - A single In-
ogy and select Intel Optane. tel® Optane™ SSD
2. Select Disable. automatically config-
3. Select Yes when prompted “Are you sue you want to disable?” ured as a single vol-
4. Select Disable and the system will clear the data. ume disk, designed o
5. The system will then return to the Intel Rapid Storage Technology menu. St 1D BT St

without any data storage
options.

Battery Low Alarm Beep (Advanced Menu)

Use this menu item to enable/disable the battery low alarm beep.
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I Setup Utility - Security Menu
insyde insyde

Security Menu .

The changes you make

here affect the access R SecuEity

to the BIOS utility itself, Set Supervisor Password

and also access to your Mair Set Supervisor
machine as it boots up 1PM Configuration Password
after you turn it on.

These settings do not the length of

affect your machine or it greater than one character.
network passwords
which will be set in your
software OS.

Figure5-9
Security Menu

Set Supervisor Password (Security Menu)

You can set a password for access to the BIOS. This will not affect access to the
computer OS (only the BIOS). An on-screen keyboard is available to assist with
keyboard input.
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Note: To clear existing supervisor passwords press Enter and type the existing pass-
word, then press Enter for the new password (without typing any password entry)
and Enter again to confirm the password clearance. To clear a user password just
click on Clear User Password.

Set User Password (Security Menu)

You can set a password for user mode access to the BIOS. This will not affect access
to the computer OS, (only the Setup utility) unless you choose to set a Password on
Boot (see below). Some menu items in the BIOS cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Power on Password: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a Power on Password if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.

BIOS Utilities

N2
2

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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TPM Configuration (Security Menu)

This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to access the Security Device Support menu
and select Enable to support TPM. To reset the TPM select Clear TPM to clear ex-
isting TPM information (see “ Trusted Platform Module” on page 6 - 57).

¢ > Trusted Computing

Figure5- 10
Security Menu
TPM Configuration

© VOO © ©
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Setup Utility - Boot Menu e

/s \Y

insyde , insyde BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
=] [OH

¢!) Boot > EFI

.. Enabled

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these

pages.

Figure5- 11

3 @) @@ @@ @ ” Boot Menu

EFI (Boot Menu)
Press Enter to Enable/Disable any available device from which to boot under EFI.
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UEFI Setting (Boot Menu)

The Unified Extensible Firmware Interface (UEFI) specification provides a clean in-
terface between operating systems and platform firmware at boot time. In contrast
to BIOS, UEFI defines a set of standard boot and runtime services. The Network
Stack item can be enabled/disabled as an option under UEFI Setting.

lnsyde

iNnsyde

¢l) Boot > UEFI Setting

@ Network Stack Disabled >

Main

=\

Advaneed Legacy PXE OPROM

Security

Network Stack

Figure5- 12
UEFI Setting

g4 © © 00O 6

Select It hange Values

Exit
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Setup Utility - Exit Menu

insyde , insyde Figure5- 13
Exit Menu

-::{] Exit

Exit Saving Changes Exit Saving Changes cg
Exit Discarding Changes

LeadOpEmatisauis Exit system setup and save your
Discard Changes changes,

Security

9 0 © 0eEee e @ ©
Click Exit Saving Changes (or press F10) to save all changes made and exit the BI-
OS. Choosing Exit Discarding Changes will wipe out any changes you have made
to the Setup and exit the BIOS. You can also choose to Load Optimal Defaults (or
press F9) to return the BI OSto its original state, and erase any previous changes you
have made in a previous session. Select Discard Changes to cancel any changes
made in the current session.
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Chapter 6: Modules & Options 7

N

Y/

i Wireless Device
ove rview Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please B FRESEEToET S
contact your service representative. electronic transmission

devices aboard aircraft
* SATA Mode Setup (Optane™, RAID or AHCI) is usually prohibited.
* Wireless LAN Make sure the WLAN &
 Fingerprint Reader Module Bluetooth module(s)
* Bluetooth are OFF (or the system
* Intel® Speed Shift Technology Driver I;,;OLn a?:ﬁ‘;:g t“r:l: ii%lf
* Intel® Rapid Storage Technology puter aboard aircraft
¢ PC Camera Module (see
* Trusted Platform Module )
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RAID Solid State
Drives

A RAID system is sup-
ported by Intel SSD mod-
ules only. All SSDs in a
RAID should be identical
(the same size and Intel
brand) in order to prevent
unexpected system behav-
ior.

SATA Mode Selection

The SATA mode selection
should be made before in-
stalling your operating
system.

DO NOT change your se-
lected SATA mode unless
you intend to reinstall your

operating system. Make
sure you have backed up all
your data before doing so.

See

SATA Mode Setup (Optane™, RAID or AHCI)

Note that your system can be set up as a RAID OR to support Intel® Optane™,
it cannot be set to support both systems.

AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance).

Intel® Optane™

Intel® Optane™ is a combination of a compatible memory device and Intel® Op-
tane™ Memory and Storage Management. This combination is designed to speed
up your system performance by caching boot data, executables, frequently accessed
data and system page files to an non volatile, low latency Intel® Optane™ SSD.

Contact your distributor or supplier to see if your system supports this technology.

RAID

To configure your RAID (Redundant Array of Independent Disks) system in Strip-
ing (RAID 0) or Mirroring (RAID 1) modes (see Table 6 - 1, on page 6 - 4) you will
require at least two identical (see sidebar) SSDs. Note: A RAID system is sup-
ported by Intel SSD modules only.

6 - 2 SATA Mode Setup (Optane™, RAID or AHCI)
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Intel® Rapid Storage Technology Application

Make sure you install the Intel® Optane™ Memory and Storage Management Z
application if you have set up your SSDs in RAID, OR Optane™ mode (see “| RST Intel® Optane ™
Driver Installation” on page 6 - 30). Intel® Optane™ is a combi-

nation of a compatible

After setting the SATA mode to Intel® Optane™ and installing the Intel® Rapid memory device and Intel
Storage Technology driver, DO NOT uninstall the Intel® Rapid Storage Tech- Rapid Technology soft-

. ™ ol ware. This combination is
nology driver or Intel® Optane™ Memory and Storage Management applica designed to speed up your

tion. system performance.

Contact your distributor or

See “RAID Setup” on page 6-5or “ Intel® Optane™ Setup Procedure” onpage 6 | supplier to see if your sys-

- 11 for further details. tem supports this technolo-

9y-
SATA Mode

Note that your system can be set up as a RAID OR to support Intel® Optane™, Selection

it cannot be set to support both systems.
If you have installed the
Windows OS with AHCI,
or Intel RST (Optane/
RAID) mode enabled, DO
NOT disable the set mode
(if you wish to disable the
set mode you will need to
reinstall the Windows OS).

SATA Mode Setup (Optane™, RAID or AHCI) 6 - 3
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Table6-1
RAID Levels

4

Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A  Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the 1/O load
across the channels
and drives.

RAID Level Description

Identical drives reading and writing data in parallel to increase performance. RAID 0
RAID 0 implements a striped disk array and the data is broken into blocks and each block is
written to a separate disk drive.

Identical drives in a mirrored configuration used to protect data. Should a drive that is
part of a mirrored array fail, the mirrored drive (which contains identical data) will
handle all the data. When a new replacement drive is installed, data to the new drive is
rebuilt from the mirrored drive to restore fault tolerance.

RAID 1

Z &
SATA Mode Selection

The SATA mode selection should be made before installing your operating system.

DO NOT change your selected SATA mode unless you intend to reinstall your operating
system. Make sure you have backed up all your data before doing so.

Solid State Drives

A RAID system is supported by Intel SSD modules only. All SSDs in a RAID should be
identical (the same size and Intel brand) in order to prevent unexpected system behavior.

6 - 4 SATA Mode Setup (Optane™, RAID or AHCI)
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RAID Setup

To configure your RAID (Redundant Array of Independent Disks) system in Strip-
ing (RAID 0), Mirroring (RAID 1) or Recovery modes (see Table 6 - 1, on page 6 -
4) you will require two identical solid state drives.

You need to setup a RAID before installing your Windows 10 operating system, and
you will need to prepare the following in order to do so.

* The Microsoft Windows 10 OS DVD or |oaded on a bootable USB flash drive.

* A connected external DVD drive (or bootable USB flash drive).

* Two Identical solid state drives.

» The Device Drivers & Utilities + User’s Manual disc (or the folder
Options\RAI D\fevmdflpy-x64) from the disc copied to a USB flash drive .

(see over)

SATA Mode Setup (Optane™, RAID or AHCI) 6 - 5
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Figure6-1
Create RAID Volume

wn

ok

Start up your notebook computer and press <F2> to enter the BIOS and go to the
Setup Utility.

Select the Advanced menu.

Select SATA Mode (see page 5 - 17), press <Enter> and select “Intel RST
Premium With Intel Optane Acceleration” and select <OK>.

Press <F10> to “Save and Exit” and select <Yes> .

As the computer restarts press <F2> to enter the BIOS again and go to the Setup
Utility.

Go to Intel(R) Rapid Storage Technology (Advanced menu) and select “Create
RAID Volume”.

B, Advanced > Create ﬁAI’D Volume

(2]

= Create RAID Volume

= SATA 0.4, TOSHIBA

MQO1ABFO50 |.
Advanced

MName:
RAID Level:

Volumel =
RAIDO (Stripe) =

X6PEPSLKT, 465.7GB
X - to Select Disk

= Select Disks:
SATA 0.1, SAMSUNG MZ...
SATA 0.4, TOSHIBA MQO..

Strip Size:

Capacity (MB): 488392 s | T

o 4

Boot -

<J @ © PEPEE & ® @

Select Item Select Item ange Values Select SubMen Setup Defaults

Create Volume
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7. You can now setup your RAID volume using the installed SSDs.
8. Select “Name” and type a name of your choice for your RAID volume and select
<Yes>.

g, Advanced > Create RAID Volume

reate RAID Volume

SATA 0.1, SAMSUN
SATA 0.4, TOSHI

Name: Volumel >
RAID Level: A AStripe) =

4B i, Figure6- 2
Select Disks: (LW n v = RAID Name

Strip Size:

Capacity (MB):

Create Volume

3 ® ©® OO0 O® G®

Select Item Select Item Change Values S

9. Select RAID Level and choose the RAID Level required (see Table 6 - 1, on
page 6 - 4 for details) and press <Enter>.

e RAIDO (Stripe)
¢ RAID1 (Mirror)
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10. Go to any of the disks listed under “Select Disks:” and select a disk name.
11. Click on X to select the disk required.

RAID Level: RAIDO (Stripe) >

Select Disks:
SATA 0.1, SAMSUNG MZ...

Figure6-3 Strip Size: i g
Select Disks Capacity (MB): & 288392 5

Create Volume

12. You should select two identical SSDs to form your RAID volume.

13. If you have selected RAIDO (Stripe) then you can adjust the “Strip Size” to (you
can use the cursor to move up and down the menu selection) your requirements (it
is recommended that you set the “Strip Size” to 128KB).

14. Select Create Volume (make sure you have selected your disks).

15. The system will list your RAID volume.

6 - 8 SATA Mode Setup (Optane™, RAID or AHCI)
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16. Select “Save and Exit’, and make sure the Windows 10 OS DVD is in the DVD
drive, or on a USB flash drive, as the computer starts up it will automatically boot
from the Windows 10 DVD or flash drive.

17. Press <F2> as the computer starts up and select Boot Manager.

18. Click to select the drive containing the Windows 10 OS.

19. Click Next > Install Now to continue installing the operating system as normal
(see your Windows documentation if you need help on installing the Windows
0S).

20. Follow the on-screen instructions to install the Windows 10 operating system.
21. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 4 (make sure you install the IRST driver).

22. Run the Intel® Optane™ Memory and Storage Management application to
manage your RAID volume as instructed in “Intel® Optane™ Memory & Storage
Management Verifying RAID Volume” on page 6 - 39.

SATA Mode Setup (Optane™, RAID or AHCI) 6 - 9
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Deleting a RAID

If you wish to delete an existing RAID then follow the procedure below to do so. How-
ever backup up any necessary files and data before deleting a RAID, as doing so
will result in the loss of all data on the RAID volumes.

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Select Intel(R) Rapid Storage Technology (in the Advanced menu).
3. Select the RAID (listed under RAID Volumes:).
4. Select Delete.
5. Select “Yes” (note that al the data on the volumes will be lost).
[B, Advanced > Delete
@ Delete
] Yes
Fl gure 6 = 4 =  Delete the Rhu? vaolume? @\
Delete RAID @\ : ALL DATS ON VOLUME WILL BESSSSI g‘c;ke!'tig:or:guAT;_wul reset the

Advanced
Yes

No

Security

*El ® © PEEEO © ® ®

Select Item Select Item Change Values Select wlts
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Intel® Optane™ Setup Procedure

After initial setup make sure you install the Intel Rapid Storage Technology driver L&

- see “IRST Driver Installation” on page 6 - 30). Optane SSD Module

You need to setup Intel® Optane™ before installing your Windows 10 operating Rl

system, and you will need to prepare the following in order to do so. If you need to remove an
installed Optane SSD

« The Microsoft Windows 10 OS DVD or loaded on a bootable USB flash drive.  JESsEEaEEREccls
. . you must disable) Intel
* A connected external DVD drive (or bootable USB flash drive).

- - Optane before doing
* An Intel® Optane™ SSD and a system SSD installed in your system. so.

» The Device Drivers & Utilities + User’s Manual disc (or the folder
Options\RAI D\févmdflpy-x64) from the disc copied to a USB flash drive .

Failure to disable Op-
tane before removing an
Optane SSD module will
1. Start up the computer and press <F2> as the computer starts up and select Boot result in the system be-
Manager, however ensure that the condition in the bulleted points below/ ing unable to start up.
overleaf are met before doing so.

¢ Make sure the Windows 10 OS DVD is in an attached DVD drive, or is loaded
on a bootable USB flash drive in one of the USB ports, as the computer starts up
it will automatically boot from the Windows 10 OS DVD/USB flash drive (you
will be prompted to press a key to boot from the DVD/USB flash drive).

SATA Mode Setup (Optane™, RAID or AHCI) 6 - 11
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*  You will also need the Device Drivers & Utilities + User’s Manual disc in an
attached DVD drive, or alternatively you can copy the following folder to a USB
flash drive:

» Options\RAI D\févmdf|py-x64

Click to select the DVD or USB flash drive containing the Windows 10 OS.

Press a key at system startup to begin installing Windows from your Microsoft
Windows 10 disc/flash drive.

4. Click Next > Install Now to continue installing the operating system as normal
(see your Windows documentation if you need help on installing the Windows
0S).

Select Custom: Install Windows only (advanced).

6. Windows will display a message stating that “We couldn’t find any drives. To get a
storage driver, click Load driver.”

Click Load Driver.

8. Click the Browse button and browse to the location you copied the files to on your
USB Flash drive or Device Drivers & Utilities + User’s Manual disc (X: denotes
your USB Flash drive):

* X:\fovindflpy-x64 (for Windows 64bit)

OR

* Options\RAID\fovindflpy-x64 (on the Device Drivers & Utilities + User’s
Manual disc)

@ N

o

N

9. Two drivers will appear in the list, and you will need to select both drivers (hold
down the shift key while left-clicking the driver names).
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10.
11.

12.

13.

14.
15.

16.

Click Next.

It is recommended that you select and then delete any existing partitions.

Click “New” to create a partition for Windows on your system SSD (not on
the Optane SSD).

Bear in mind the following when creating partitions for your system drive
and your Optane drive:

The drive partition should be set to GPT (MBR partitions are not supported).
The drive type should be basic, Dynamic drives are not supported.

It is very important to make sure that when you create any partition, to leave at
least a minimum of unallocated space of SMB (see sidebar). This space is
required for any drive that is being accelerated (System or Data Drive).

Follow the on-screen instructions to install the Windows 10 operating system.
Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 4 (make sure you install the Intel Rapid
Storage Technology driver - see overleaf).

Run the Intel® Optane™ Memory and Storage Management application to
enable and manage your Intel® Optane™ system (see “Intel® Rapid Storage
Technology” on page 6 - 30).

Modules & Options

Creating a Windows
Partition for Optane

When installing Windows
on your system SSD,
make sure that you leave a
minimum of 5MB of unallo-
cated space for the Intel®
Optane™ software to cre-
ate needed metadata.

After you have created a
Windows partition the Win-
dows Setup screen will
display the partitions and
sizes, including the unallo-
cated space. If the unallo-
cated space is less than
5MB, then delete the parti-
tions and recreate them un-
til the criteria is met.

Note this is 5MB only, not
GB.

SATA Mode Setup (Optane™, RAID or AHCI) 6 - 13
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Wireless LAN

If your purchase option includes the Combination Wireless LAN & Bluetooth
module then install the driver as instructed overleaf.

2NZ
&
Wireless Device

Operation Aboard

Alfcrat Make sure you install the drivers in the order indicated in Table4 - 1, on page4 - 4.

The use of any portable

electronic transmission Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
devices aboard aircraft & Bluetooth Combo modules.

is usually prohibited.

WELCEHERGER VLR See overleaf for the appropriate driver installation instructions.
Bluetooth module(s)

are OFF if you are using

the computer aboard

aircraft by putting the

system in to Airplane

Mode (see

).
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Intel® WLAN Driver Installation

1.

SNk w

~ o

Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Click Next.

Click in the check box to agree to the End User License Agreement and click
Install.

Click Finish.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 16).

Modules & Options
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Figure6-5
WiFi & Network
Connections

6 - 16 Wireless LAN

WLAN Configuration in Windows 10

You can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

PoON~

F3 -~
Click the Wireless icon in the notification area of the taskbar.
Make sure that Airplane mode is off (the Airplane mode icon should be gray).

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Connect Automatically

It is recommended that you
check the box to Connect au-
tomatically.

This will cause the system to
check for the access point
upon startup, and resuming
from a power-saving state,
and will remove any necessity
to keep connecting manually.

ﬂ@ RMA
8

17z CRMA
ﬂﬁ T

@ Guest

Disconnect

Bﬁ RMA

8,
AR

EA Connect automatically

afff:TW

ﬁ Guest

B@ PM72-2.4G
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Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

When you are connected to the network access point it will display Connected
S Connected |

Select any connected network and click Disconnect [E2ayuaa to disconnect
from a connected access point.

Bﬁ Open

Connected

Wireless Device
Operation Aboard Aircraft

Properties

Disconnect

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited.

Figure6- 6
Network Connected
(Click Disconnect)

Make sure the module is either OFF or
in Airplane mode if you are using the
computer aboard aircraft.

e 2
Mobile
Airplane mode  hotsp

Wireless LAN 6 - 17
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Figure6-7
Network & Internet
Settings

9.  You can click the Airplane Mode button to turn the mode On or Off.

10. You need to either use Airplane Mode, or to turn the WLAN module off aboard
aircraft.

11. If you click on Network Settings to bring up Network & Internet for a more
comprehensive list of network and internet settings including Wi-Fi (can be turned
on/off), Airplane mode (Airplane mode and Wireless devices can be turned on/off)
VPN, Dial-up, Ethernet and Proxy.

& Setinge € tetings
. G Home i-Fi
G Home Airplane mode wizh
- [ Fnd 2 satting | win
setting wrm this on ta stop afl wirsless commur | &
and Bluetooth & o
Motwork & Intorrst
Hacaiic A bitr i & o & open
S st
& stans Wireless devices i o
- WeH Hirdware properti
A Wi Wi-F
- o © o
12 Ethernet
= Duatup
Hotspot 2.0 networks
= Diakup @ Get hal
i Hatspat 200 networks make it mose secure 1o connect 10 public Wi
&£ Give feedback featspeats. Thary might b avadabile i public places like aipons, hat
o e Aiplane mode andl cafes
| = Airplane mode Wt B kit Let ve Sign-Up 16 et connected
(] Pn
L iMe et Bty When you turm this on and choose a Motspot 2.0 netwar we'll sh
list of providers 1o choose from 5o you can get ondne
& Proxy
@ Connect to a wireless network

Network & Internet
Wi-Fi, airplane mode, VPN
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Fingerprint Reader Module

(Optional for Model A Computers)

The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

There are two different fingerprint modules supplied with this model. Install the
driver from the Device Drivers& Ultilities+ User’sManual disc by following the
appropriate instructions on the page overleaf.

The fingerprint reader module uses the Sign-in options configuration of the Win-
dows Account.

Modules & Options

Fingerprint Reader

and Power Saving
States

If your computer is in a
power saving state (e.g.
Hibernate or Sleep) you
should keep your finger
clear of the fingerprint
sensor.

Allow the system to fully
resume before swiping
your finger across the
sensor.
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Fingerprint Reader Driver Installation

1. Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into the DVD drive.

Click Option Drivers.

Click 2.Install Fingerprint Driver > Yes.

Click OK to complete the installation.

The fingerprint reader module uses the Sign-in options configuration of the
Windows Account (see overleaf).

Nk w

.|
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Fingerprint Module Configuration 3

/
1. Click the Settings item in the Start Menu and then click Accounts and click Sign- ’Zl‘
in options. PIN Code

2. You will need to add a Windows passworc_i (click Add under Password). You will be asked to add
3. Af_ter you have added _the password yc_)u will nfaed to also add a PIN. a PIN code when setting
4. Click Set up under Windows Hello Fingerprint. up the Fingerprint Read-
5. The wizard will then guide you through the set up process to scan your fingerprints. er. This is in addition to
e — your windows pass-

i : word.

G Home Sign-in options

Find a sefting | Manage how you sign in to your device Note this code as it r=1%
Accounts Select a sign-in option to add, change, or remave it be required to help you
e i MR i sign-in if there are any
ke B Wedos ek x issues with using the fin-
= B S o oot e Bt gerprint reader to sign-in

You can sign in to Windows, apps, and senvces by teaching (See
£, Sign-in options Windows to recogrise your fingerprint.
- = Leam more )
A, Family & other users o
121 Windows Hello PIN
B g vith & PN Decoiimaridact

> Sync your settings

ﬂ Security Key . Touch the fingerprint senser
SH i whha prossto securiy hay Rapaatedly lift and rest your finger on the sensee Lkl satup )
| Mo - e Figure6 - 8
Sign in with yolsr sccount’s passward Accounts - S|gn-|n
Bd options
Carxel

(Add Fingerprint)

Require sign-in

1 you've been away, when should Windows require you to sign in again?
[t oo o <1
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6. You will be instructed to Touch the fingerprint sensor (simply touch the sensor)
on the reader a number of times (lift and touch again).

Figure6-9
Rest & Lift Your
Finger

Kirep resting and bting your frger

-

7. Try to present different parts of your finger in different positions (similar to the
various positions you may use when using it, and if you see red at any point try a
different position).

Click Set up PIN if you need to add a PIN.

You can choose to Add another finger (this is recommended) or Remove the
current fingerprint reading.

10. You can now scan your fingerprint to log-on to the computer.

MANL
2§

Fingerprint Sign-In Issues

8.
9.

If at the Windows Hello screen, the Fingerprint reader fails to recognize the fingerprint 3 times it
will then block access to the computer.

In this case you will need to use your PIN (the PIN you used when initially setting up the fingerprint
reader) to access the computer. Alternatively you can sign-in using your windows password.

After using the PIN code (or windows Password) to access the computer you can go to the Settings
> Accounts > Sign-in options if you wish to change any settings.
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Bluetooth .
Y/ \Y
If your purchase option includes the Combination Wireless LAN & Bluetooth . .

. . . Wireless Device
module then install the driver as instructed overleaf. Operation Aboard

Aircraft

Make sure that the module is on (i.e. the system is not in Airplane Mode) before in-
stalling the driver. The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.

4

Bluetooth Data Transfer ML Sl e L L =

Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.

. |
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Intel Bluetooth Driver Installation

1. Make sure the system is not in Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Select the setup type (Typical is recommended) and click Install.

Click Finish.

See “Bluetooth Configuration in Windows” on page 6 - 25 for configura-
tion instructions.

PN R WD

. |
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Bluetooth Configuration in Windows
1.

2.
3.

Go to the Settings control panel and click Devices (or click the Bluetooth icon
in the taskbar and click Add a Bluetooth Device).
Click Bluetooth & other devices and make sure Bluetooth is On.
Click Add Bluetooth or other device > Bluetooth (Add a device) and a list of
discovered devices will appear.
S e Add a Bluetooth Device
@ Home Bluetooth & other devices Allow a Device to Connect
| I Add Bluetooth or ather device Show Bluetooth Devices
o — Send a File
il Bluetooth & other devices - on Receive a File
ﬂ Printers & seanners Now discoverable as "DESKTOP-FS3BEDC” Join = persona| Area NebNDrk
0 Mouse
Mause, keyboard, & pen Open Settings
el Touehpad D Comfort Optical Mouse 1000
- Remowve lcon
Yping
Audio
el ﬂl)) BE24A (Intel(R) Display Audic) '|) AL P E
@ Auobiay S 7/8/2020 =
0 uss

Add a device

Other devices

Add a device

Choose the kind of device you want to add.

Mice, keyboards, pens, or audio and other kinds of Bluetooth devices

Modules & Options

Figure6 - 10

Settings > Bluetooth

& Other Devices
(Add a Bluetooth
Device)

Figure6- 11
Add a Device
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4. Double-click the device you want to pair with the computer and click Connect, if
the PIN matches that on the device to which you wish to connect (you may
need to click paid on the device).

Add a device

Add a device

Make sure your device is tumed on and discoverable. Select a device below to

connect.

. Add a device
Figure6- 12
iPk
Bluetooth Connect [t

L g

Your device is ready to go!

Pri onnect if the PIN on iPhone matches

718680
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5. Select a device and click Remove Device Remove device
any device (click Yes to confirm).

to disconnect from

&«

Settings

@ Home

] Find a setting

8 0O o &

(=]

Devices

Bluetooth & other devices

Printers & scanners

Mouse

Touchpad

Typing

Pen & Windows Ink

AutoPlay

USB

Bluetooth & other devices
+ Add Bluetooth or other device
Bluetooth

@ o

Now discoverable as "DESKTOP-HLBIH3F"

Mouse, keyboard, & pen

o USE Optical Mouse

Other devices
% 802.Mac NIC

— Mass Storage Device

(’&) iPhone
Paired

OQD iPhone
Connected

Ca>

Modules & Options

Figure6 - 13
Bluetooth Remove
Device
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To Make your Computer Discoverable to Bluetooth Devices

1. Go to the Settings control panel and click Devices (or click the Bluetooth icon
in the taskbar and click Open Settings).

2. Click Bluetooth & other devices and click More Bluetooth options.

3. In Bluetooth Settings make sure that Allow Bluetooth devices to find this PC
check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Notifications) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

N G € Bluetooth Settings e
G Home Bluetooth & other devices Options | COM Forts Hardware
| Find 4 setning | . 3 .. R Discaovery
. []iAllow Bluetooth devices to find this PC
[ pownizas aver meteres connections Ay Bluetooth devices will see the name of this PC.
TR Blustooth & other davices f it thiis af "t
S Printers & seanears 4 o
. Notifications
FI gur e 6 - 14 O v Alert me when a new Bluetooth device wants to connect
S Tumn on Bluetooth even faster b
1 =l Touchpad
Bluetooth Settings
B Typing : Show the Bluetooth icon in the notification area

Pen & Windaws Ink
& - Related settings

@) AutoPlay

Restore Defaults
Help from the web
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Intel® Speed Shift Technology Driver

Install the Intel® Speed Shift Technology driver as outlined below. Speed Shift
Technology allows operating system to hand off some or all control of the handing
of the computer’s *P-States to the processor. This has a couple of noticeable benefits | P-states are voltage-fre-

in responsiveness and the reduction of power consumption. e
speed and power con-

Z
*P-States

Speed Shift Technology Driver Installation 222"30“ R
1. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached . ' .
. en the operating volt-

DVD drive. age of the processor is
2. Click Option Drivers (button). lower, so is the power
3. Click 4.Install Speed Shift Driver > Yes. consumption.
4. When the “Isthis package from a source you trust?”” message pops-up click

“Yes, add it”.

5. This will complete the installation procedure.

.|
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¢ Intel® Rapid Storage Technology

z

N
IRST and M.2 PCl-e Install the Intel® Rapid Storage Technology driver to support your Intel® Op-
SSDs tane™ or RAID system, or if your BIOS is set to Intel RST Premium With Intel
Nt con = Optane System Acceleration (supporting RAID). Note this driver is required
Storage  Technology for Intel Optane or RAID systems only, and you need not install the driver if
CEEERUEIEL R your system does not have an Optane SSD or RAID, and your SATA mode in

SSDs with a PCl-e In- .
terface (M.2 SSDs with the BIOS is set to support AHCI mode.

a SATA |Interface are
supported). IRST Driver Installation
Optane SSD Module 1. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached
Removal DVD drive.
WEELEEERE DTS 2. Click Option Drivers (button).
il 3. Click S.nstall IRST Driver > Yes.
e ok en 4. Click OK > OK (make sure you click all the OK messages which pop-up) to
in the BIOS before doing complete the installation.

== _ 5. Click Restart Now to restart the computer.

Ea"”re SRR SEEEEE 6. Run the Intel® Optane™ Memory and Storage Management app from the
efore removing an Optane

SSD module will result in Apps screen.

the system being unable to . . A A

start up. See the following pages for more information if you have set your system for Intel®

Optane™ or RAID. After setting the SATA mode to Intel® Optane™ and install-
ing the Intel® Rapid Storage Technology application, DO NOT uninstall the
IRST driver or Intel® Optane™ Memory and Storage Management application.

6 - 30 Intel® Rapid Storage Technology



Modules & Options

Intel® Optane™ Memory & Storage Management

Run Intel® Optane™ Memory & Storage Management from the Start menu in
Windows.

Intel® Optane™ Memory and Storage Management

Your storape system is functioning normally.

Storage System View

(?1 ;?11e£-ﬁ Optane’™ b Click on any component below 1o manage its properties FI gure 6 = 15
emory i lick on any compo &low 1o manape its properties., >
Performance i U saTa nard disk (466 GE) (System) Intel® Optane
Memory & Storage
. [ Rescan | Management
ﬂ About f
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There are five areas on the left panel of the application and you can click on Intel®
Optane™ Memory to manage system acceleration with the Optane memory sys-
tem. Select the Optane memory module, and then click Enable Intel® Optane™
Memory to start the process.

Intel® Optane™ Memory and Storage Management

Figure 6-16 }‘ Manage Status
b Intel® Optane™ @ Create RAID Volume Disabled
Menqugg‘e:::;?ge e Intel® Optane™ Select fast Intel® Optane™ memory drive:
(Intel® Optane™ o 64 GB Intel® Optane™ Memory (Controller 1, Port 0) v
Memory) Performance

Select a compatible drive to be accelerated:

Q Settings Phison SSMP256GTE3C2-511 (Controller 0, Port 4) (SYSTEM) v

O ~bout Enable Intel® Optane™ Memory
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Enabling Intel® Optane™

1. Run the Intel® Optane™ Memory & Storage Management application.
2. Click Enable Intel® Optane™ Memory.

Intel® Optane™ Memory and Storage Management F| gure 6 _ 17
F Manage Status Enable Intel®
e Create RAID Volume Disabled OPtaneTM Memory

Intel® Qptane™ Select fast Intel® Optane™ memory drive:
s
=MLY, 1 64 GB Intel ® Optane™ Memory (Controller 1, Port 0) AP
Performance
Select a compatible drive to be accelerated:
£+ settings Phison SSMP256GTB3C2-511 (Controller 0, Port 4) (SYSTEM) \Enable

T R P T

3. A warning will pop up to notify you that the Optane Memory Module will be erased,
and if this is OK then click Enable.

Intel® Optane™ Memory Status

WARNIMG: This process will erase all data on Intel® Optane™ F| gure 6 - 18
memory module. Please back-up any data on this module before .
continuing. Warnlng

NOTE: This process WILL NOT erase data on any other drives in your
system.

NOTE: To avoid the risk of data loss, Intel® Optane™ memory must be
disabled before moving this device to another system.

/| Erase all data on Intel® Optane™ memory module.
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4. The system will prepare and enable the Optane drive, and when finished you can
then click Restart.
Figure6- 19

Restart Is Required
Restart 9

To work with Intel® Optane™ memory, restart is requirad.

The system will then optimize the Optane Memory upon restart.
Run the Intel® Optane™ Memory & Storage Management application.
The system status will then be displayed.

Noo

Intel® Optane™ Memory and Storage Management

Your storage system is functioning normally.
Status 9 Create RAID Volume
Storage System View
Intel® Optane™
() Click on any com t below t it: ti
Memory y ponent below to manage its properties.
i Intel® Optane™ Memory Arra;
* Pinning P Yisie¥
Intel® Optane™ Memory Volume
Performance a HCle{53:50) Type: Intel® Optane™ Memory
238 GB
ﬁ Settings U SAl(38.60)
o About

@ Internal empty port 3
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Intel® Optane™ Memory and Storage Management

A Manage Intel® Optane™ Memory Status

Intel® Optane™ memory is enabled and accelerating your system.
e Create RAID Volume B ¥ BXONL

70 Intel® Optane™ FIgUI’e 6 = 21

Memory ™
Total Installed System Memory @ Intel® Optane

# Pinning Memory

80 GB = 64 GB Intel® Optane™ Memory + 16 GB RAM
Performance

a' Settings

PCle Intel® Optane™ Memory (55 GB) (55 GB)
@ rvou Firmware: K4110410

Intel® Optane™ Memory Volume Configuration

.Lr SATA SSD (238 GB) (238 GB)
Firmware: SBFM61.1

Usable Drive Capacity: 238 GB

Module Usage @

Bl Auto-managed/system files 457GB  (83.1%)
B User-pinned content 0GB (0.0%)
Unused Space 93GB  (16.9%)

Optimization Schedule @

Last Optimization Mot run
Next Optimization  7/25/2020 2:00 AM
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8. You can drag and drop files, folders and applications so that they will always
benefit from the speed of Optane Memory from the Pinning menu (if your
Optane SSD is greater than 32GB)..

Figure6 - 22

Pinning
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Intel® Optane™ Memory & Storage Management for RAID Systems
The Intel® Optane™ Memory & Storage Management application application
also displays status information on your RAID configuration. Run the Intel® Op-
tane™ Memory & Storage Management from the Start menu in Windows.

When the application is launched the system will open the Manage window where
you can view the general health of the storage system. Various volume creation and
management options are available depending on the system’s status.

= Intel® Optane™ Memary and Storage Management E e
|

Storage System View

“ |.lm',|u - FI gure 6 - 23
477 perollee 1,3 Intel® Optane™
’ PCle S50 (230 GB) - 3 Memory & Storage
0 saTA hard disk (466 GB) [System) ”J:,,; 3 i Ma n ageme nt

l..ﬂ.l;_1‘0‘;0‘_“0‘76&_Wol_oolo_uua_du
P RAID Status
Cor al er: 181930900164
M PCSNT20 SDAPNTW-256G

.|
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Intel® Optane™ Memory & Storage Management Help & Support
Click the link in For help and support ... in the About menu to go to the Intel sup-

port page.
(e Intel® Optane™ Memory and Storage Management
A Manage Intel® Optane™ Memory and Storage Management

e Create volume Product Version: 17.8.1007.0

Driver Version : 17.8.0,1063
018-2019
™
(?) Intel ® Optane For help and support visit: http://intel.com/supportfoptane-m
Memory

i - [ A]
| l:'?cgrgfi Zﬂ'm BT Additional components
nte ptane ,
Memory & Storage a Settings NLog for .NET Framework 4.5 4.5.10

Copyright (c) 2004-2018 NLog Project - http://niog-project.org/
Management 0 About BSD 3-clause "New" or "Revised" License view full text
Help

Autofac 4.8.1

Copyright @ 2015 Autofac Contributors

MIT License view full text

Json.NET 11.0.2
Copyright @ James Newton-King 2008
MIT License view full text
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Intel® Optane™ Memory & Storage Management Verifying RAID Volume
To keep the RAID system data healthy and to repair data inconsistencies on the vol-
ume you should verify the volume regularly.

Run the Intel® Optane™ Memory & Storage Management application.

Click Manage from the menu on the left.

Click to select the RAID icon.

Click Verify volume (in some cases you may be required to initialize a volume
before verification).

howN =

Intel® Optane™ Memory and Storage Management

Your storage system is functioning nermally,
e Create volume

Storage System View
Intel® Optane™
7 P!

Memory b Click en any component below lo manage its properties, Fi gur e 6 - 25

Performance i N Intel® Rapld

MyRaid1 MyRaid1
£ Settings A paie sso@3sc8) Ty RAIDO : Storage

G Status: N

s Sistem vahime: N Technology

@ Avout A roiesso 238 cr) Initialized: Yes .
Rename volume Ve rlfy

Delete volume
Werify volume

1 saTA nard disk (466 GB) (System)
o RAID 0

Write-cache buffer flushing:
@D oo

Cache mode: OFf
Modify Cache Mode

Verify Volume
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5. Click Verify to begin the process.

Intel® Optane™ Memory and Storage Management

9 Create volume

Keep your data healthy by identitying and repairing data
inconsistencies on your volume,

Intel® Optane™
7 P
Memary

Performance @
ﬂ- Settings

Mare help

o About

Intel® Optane™ Memory and Storage Management

Figure 6 - 26

Status
Inte|® Rapld a i | Your storage system is functioning normally.
Stora e reate volume 4
9 Storage System View
Technology (5 ntel® Optane™ -
RAID Veriﬁcation 4 Memory L lick on any component below to manage its properties.
SATA_Al 0000
Performance T
MyRaid1
a Settings a PEISSSD;{2381GE) Type: RAID O
477 GB
o About E PCle SSD (238 GB) .
U SATA hard disk (466 GB) (System)
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Intel® Optane™ Memory & Storage Management Performance
Enable/Disable Link Power Management link management from the Performance
menu. When enabled it allows the SATA host bus adapter to enter a low-power state
when there is no I/O activity to save energy.

(D Intel® Optane™ Memory and Storage Management
/& Manage Configure power and performance settings

a Create volume Link Power Management
@D :eoe

Intel® Optane™

(7’ W Link Power Mana; i ingi H
gement helps the SATA device save power during idle _
Memory time when there is no /O activity or when devices are absent or FI gure 6 27
unused. Intel® Optane“"
Performance
Memory & Storage
£ settings Management
Performance

o About
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Intel® Optane™ Memory & Storage Management Settings

Enable Automatic rebuild on hot plug to automatically start rebuilding any de-
graded volume by simply hot plugging a compatible disk into the same location as
any failed or missing drive. Do bear in mind the warranty terms as outlined in the
sidebar, and you should contact your distributor or supplier for help in the case of

degraded volumes or drives.

Figure6 - 28
Intel® Optane™ (inteD)
Memory & Storage
Management A Manage
Settings

a Create volume

Intel® Optane™

o Memory

Performance

o About
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Intel® Optane™ Memory and Storage Management

Notifications settings

Current Windows notifications settings status: Enabled

Disabling toast notifications for Intel® Optane™ Memory and Storage
Management will prevent display of all notifications for this application.

Change settings

What's new window is:

@D e

Automatic rebuild on hot plug

@D :rebiea

Automatic rebuild on hot plug support allows you to automatically start
the rebuild process of a degraded volume by hot-plugging a compatible
disk in the same location as a failed or missing array disk.

| WARNING: Any existing data on the hot plug disk will be permanently
deleted as soon as the migration process starts. Back up data before
hot-plugging the disk.
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Intel® Optane™ Memory & Storage Delete and Create Volumes
You can use the application to delete and create volumes, however be sure to back
up any files and data before deleting any volumes.

1.  Run the Intel® Optane™ Memory & Storage Management application.
2. Click Manage from the menu on the left.
3. Click to select the RAID icon.
4. Click Delete volume.
5. Click Delete.
(D Intel® Optane™ Memory and Storage Management a
Manage : Delete volume
q} Croatavoliime This operation will remove all data from selected volume. Are you sure
you want to continue?
e 'Gt:r‘f; r‘;p‘a“e“‘ v Figure6 - 29
Intel® Optane™
KT TN Memory & Storage
L3 Settings Management
More help Delete Volume
o About
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6. To create the new volume click Create Volume in the menu on the left.

Intel® Optane™ Memory and Storage Management

Manage Create volume
g9
1 Name: =
Fi gure 6-30 @ Create volume [MyraiD2 Proposed Configuration
Inte |® Optane ™ o Intel® Optane™ ~ Protection
Memaor
Memory & Storage Y E5I.=ﬂ contreller:
- - Performance
Performance P
Management o [
create V0| ume Q Settings Select volume type: Capacity
0 Abét O Optimized disk performance (RAID 0)
G @ Real-time data protection (RAID 1) Combine two disks lo create a
Etficient data hasting and protection (RAID 5) "’“I”:"'P wrwr;al:'-n{: duk :m“ an
exact copy of the data an
Balanced performance and data protection (RAID 10} |mmm-\l ,‘:_I‘H"“F redundancy:

7. Type a name for the volume, select PCle, and then select the volume type (RAID
level - see Table 6 - 1, on page 6 - 4).

Click Next.

Select the array disks and any other options required and then click Next.

©®

Intel® Optane™ Memory and Storage Management

Figure6 - 31

Intel® Optane“" & Manage Create volume
Sel disks :
Memory & Storage [ Nl
/| PCle disk on Cantroller 1, Port 0 (238 GB) '
Management (7 'ntel® Optane™ st |+ PCledisk on Controller 2, Port 0 (238 GB) MyRAID2
f Memory 238 6B Type: RAID 1
Select Array Disks ’ R— . 1 e
per{OIma”Le l!ep! e data from ane of selecte. 1zks?
(O Yes: PCle disk on Controller 2, Port 0 {238 GB) Y 238ca
. N
ﬁ- Settinas @ °
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10. Click to select the data to be deleted and then click Create Volume.

11. The system will then create the volume for you.

12. Select the RAID volume by clicking on it and click Initialize and then click the
Initialize button.

AULR U G AU U ST SIUYY A THGHGET 163 1S UEa,

SATA_Array_0002

MyRAID2

Al Pcie ssD (238 B Type: RAID 1

238 GB Status: Normal
System volume: No

2 raesso23scr) Initialized: No

Rename volume

g Figure6 - 32
< Initialize ) Intel® OptaneTM

U SATA hard disk (466 GB) (System)

TyPE: RAID 1 Memory & Storage
Change type
Management
Initialize

(D Intel® Optane™ Memory and Storage Management

MyRAID2: Initialize volume

a Creatsvoliime This process could take a while depending in the number and size of
the disks. You can continue using volume data and other applications
Intel® Optane™ during this time.

Memory

Q Settings e
13. The system will then initialize the RAID.

(4
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PC Camera Module

When the PC Camera application is run the LED indicator to the left of the camera
will be illuminated (see @ Figurel-2on pagel - 6). Note that you need to use the
Camera app in Windows to take pictures and capture video. Use the Fn + F10 key
combination (see “ Function/Hot Key Indicators’ on page 1 - 11) to toggle power
to the PC Camera module.

Note that you need to use the Camera app in Windowsto take pictures and cap-
ture video.

. |
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Camera App

1.

2.

3.

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

Run the Camera app from the Start menu by clicking on the Camera app icon
(you can type “camera” into the search box to find the Camera app).

The interface displays two buttons on the right of the screen; one for photo and
one for video.

Figure6 - 33
Camera App Mode
Photo ideo Icons
Simply click on the appropriate button (or arrow) to switch to either photo or video
modes.
You can use the buttons on the left of the screen to access the Settings, HDR/
Brightness and Photo Timer.
e
Auto or Pro Modes Figure 6-34
The menu buttons displayed on the left side of the screen will depend on the Camera Menu
mode chosen in Settings . Pro mode will display the timer and bright- Buttons

ness buttons, and with Pro Mode disabled (Auto mode) the timer and HDR
buttons will be displayed.

PC Camera Module 6 - 47



Modules & Options

6. Click Settings f§ to access the camera settings menu to select/deselect Pro
mode, make adjustments for Framing grid, Photo Quality, Time lapse, Video
Quality and Flicker reduction.

SETTINGS /

Camera Settings

The Photo Timer can be set to take Photos after 2, 5 or 10
seconds.

You can use a Framing grid to help you line up pictures.

Figure6 - 35
Camera Settings

The Photo Quality can be changed to that which the system
supports.

Time lapse can be set to keep taking photos until the camera
button is pressed again.

The Video Quality resolution and frame rate can be set to any
supported by the system. Note that capturing high resolution
video files requires a substantial amount of disk space for each
file. After recording video, check the video file size (right-click
the file and select Properties) and the remaining free space on
your hard disk (go to File Explorer, right-click the hard disk,
and select Properties). If necessary you can remove the re-
corded video file to a removable medium e.g. a USB Flash
drive.

Related settings

If you need to reduce any screen flicker, change the settings
in Flicker reduction to either e.g. 50Hz or 60Hz.
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7. With the Pro mode selected (in Settings ) you can access the Brightness
button to adjust the brightness.

Figure6 - 36
Camera Brightness
Adjustment
(Pro mode)

8. In Auto mode you can toggle HDR on or off.

Figure6 - 37
Camera HDR
(Auto mode)

HDR pro
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Figure6 - 38

Video Camera

Recording in
Process

Taking Pictures/Capturing Video

1.

akrw

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

Run the Camera app from the Start menu by clicking on the Camera app icon E
(you can type “camera” into the search box to find the Camera app).

Click to select either photo or video modes.

Click the photo icon to take a picture.

C_Jlick on the video icon to start video capture (when video capture begins a
timer will appear at the bottom of the screen). N

To stop video capture click the stop o button (you can also pause the video
capture).
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7. Captured photos and videos will be saved to the Photos app stored in the Start
menu (type Photos into the search box if you cannot find the app). You can also
access the photos from the Camera roll icon at the bottom right of the Camera

app screen.

l Vi

Figure6 - 39
Photos App
(For Captured
Photos & Videos)
&

Camera Roll in the
Camera App

i P hype here to search
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IR Camera

(Factory Option)
The Infrared camera is compatible with the Windows Hello facial recognition
system. The IR Camera provides a user-friendly interface with a single form of ver-

ification to log on to your computer.

The IR Camera module uses the Sign-in options configuration of the Windows Ac-
count.

. |
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IR Camera Module Configuration
1. Before setting up the facial recognition system make sure that:

* The system is powered by the AC/DC adapter (if the system is powered by the bat-
tery then facial recognition will not work).

» Ifyou are a glasses wearer then it is recommended that you remove your glasses in
order to prevent reflection problems hampering the facial recognition system.

2. Click the Settings item in the Start Menu and then click Accounts and click Sign-
in options.

You will need to add a Windows password (click Add under Password).

After you have added the password you will need to also add a PIN.

Click Set up under Windows Hello Face.

< Settings

o bk w

@ Home Sign-in options
Find a setting £ | Manage how you sign in to your device
Accounts Select 3 sicnsinespierm Ay TN e UM oo

+ »  Windows Hello Face
_ This option is currently unavailable—click to learn more
A= Your info
Windows Hello Fingerprint
Sign in with your fingerprint scanner (Recommended)

S))

X Email & accounts

Windows Hello PIN

e
amaw
T

Q Sign-in options

Sign in with a PIN (Recommended)
B3 Access work or school Security Key
ﬁ Sign in with a physical security key

Modules & Options

4

Facial Scanning
with Glasses

If you set up Windows
Hello without glasses,
as recommended, then
you can select Improve
recognition to try the
setup again with them
on (reflection problems
from glasses will some-
times hamper the recog-
nition).

Figure6 - 40
Windows Hello
(Face Recognition)
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6. Click Get Started and the Windows Hello Setup Wizard will then guide you through the
set up process to scan your face.
7. You will need to key in the pin number on initial setup.

T
nir Windows Hello setup % |

eh b 5
—  Welcome to Windows Hello -+ Welcome to Windows Hello
P k!

L= Your device just got more personal, Say goodbye to entering = Your device just got more personal. Say goodbye to entering
complex passwords and start using Windows Hello to unlock complex passwords and start using windows Hello to unlock
your device, verify your identity, and buy things in the Store your device, verify your identity, and buy things in the Store

Nj  using your face. i using your face
Learn mare Windows Security %

to

'l Making sure it's you
non r
i | A
col
u4 X | forgot my PIM
b
Cancel
Figure6 - 41 a3
Windows Hello Eefei G q
Setup (Get Started & 'y — ! Cancel
Enter PIN) fae

8. Before the scanning process begins, once again note:

* The system is powered by the AC/DC adapter (if the system is powered by the bat-
tery then facial recognition will not work).

* Ifyou are a glasses wearer then it is recommended that you remove your glasses in
order to prevent reflection problems hampering the facial recognition system.
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9. Keep looking directly at the screen and the system will scan your face (the blue bar
underneath your picture indicates the progress of the scan).

nt{ Windows Hello setup kS

m

leq

ro!

naf

)

3

1e| Keep looking directly at your screen.

it — Figure6 - 42
an Windows Hello
Setup (Scan in

Progress)
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10. The system will then prompt with “All Set!”, so click Close to exit the Setup

Figure 6 - 43 Wizard.
Windows Hello & raie Requif e .
setup (A" Set!) & I Find a setting P | If you've B All sett
Logon Prompts Accounts |—Whenp Use your face the next time you want to unlock your device.
Tip: If you wore glasses while setting up Windows Hello,
R Your info .| select Improve recognition to go through the setup again
O Wil without them. This will help us recognize you either way.
_\ /_ Email & app accounts Improve recognition
4 \Y | Sign in to
€, Sign-in options
IR Camera and Power- s
Saving Access work or school Face o
Family & other people Set up|
If you turn off the PC © syncyour settings ;
Camera (e.g. by using ® g
the Fn + F10 key combi- "
. as
nation or Control Cen- &
ter icon) then the facial Changey:

recognition system will Change
not function.

If the system enters and
resumes from Hiber- .
g sure it's you...

nate, is restarted, or is

shut down and restarted
with the camera turned 11. Restart the computer after the scanning process has been completed.

off, then the facial rec- 12. You can use the facial recognition system to unlock your computer the next time
ognition system will not you start the system. The system will prompt with “Getting ready...” and after
function. seeing this simply look directly (as it prompts “Looking for you...” / “Making sure
it’s you..”) at the screen to complete the scan.
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Trusted Platform Module

(Optional)

The TPM security chip allows you to create and manage digital certificates for user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
a removable media (e.g. a USB flash drive) to store passwords etc. before begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
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4

Clearing TPM
Information

You can click Clear
TPM, which will toggle
the setting between En-
abled/Disabled. If set
to Enabled this will
clear existing TPM in-
formation in order to re-
set the TPM.

Figure6 - 44
Security - Trusted
Computing

Enabling & Activating TPM

A e

Restart the computer.

Enter the BIOS pressing F2 during the POST/startup.

Click to enter the Setup Utility and select the Security menu.

Click TPM Configuration and select Enable for Security Device Support.
You will then need to save the changes and restart the computer.

Ginsyde oo e
A 10:52:40

J © © 0POPEe © ©® @
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TPM Management in Windows
You can manage your TPM settings from within Windows:
1. Go to the Control Panel.

2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

% BitLocker Drive Encryption = O
«— « 4 “X « All Control Panel ltems > BitLocker Drive Encryption v O | Search Control Pane pel
Control Panel Home Q
BitLocker Drive Encryption a
Help protect your files and folders from unauthorized access by protecting your drives with .
BitLocker. Flgure 6 = 45
BitLocker Drive
Operating system drive Encryption
TPM
C: BitLocker off ( B :
Administration)

G Turn on BitLocker

IR

Fixed data drives

Removable data drives - BitLocker To Go

MEMSTICK (D:) BitLocker off
&) TPM Administration 3

Privacy statement $ TPM ﬁdmiﬂlﬂr’aﬁoﬂ
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

W Trusted Patform Module (TPM) Management on Local Computer

@ e Action  View Window Help

&= | HMm

Figure 6 - 46
Trusted Platform
Module (TPM)
Management on
Local Computer
Administration
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T TPM UL DRI Rl Tl TPM Management on Local Computer

TPM Management on Local Computer
¥ Configures the TPM and its suppont by the Windows platform

Overview =
Windows computens containng the Trusted Platfoem Module (TPM) secunty hardware provide enhanced
secusiy features for applications. This snapn displays information about the computer's TPM and slows

adminssiratons 1o configure the device. | also allows administratons to view and manage commands
undersicad by the davice

Status -

The TPM i ready for use, with reduced functionaity.

TPM Managemeni =
a Change TPM owner password,
a Dear the TPM to remove ownership and reset the TPM io faciory defauls.

WARNING: Clearing the TPM causes you to lose al TPM keys and data protected by thoss keys

TPM Manud acturer Infomation

Marfacturer Name: IFX Manufacturer Verson: 5.0 Spaciication Verson: 2.0

Actions
TPM Management on Local Computer -

Prepare the TPM...

Change Chamer Password...

Clear TPM...

Reset TPM Lackout...

View »
New Window from Here

Refresh

Help
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. Atfter the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Actions
TPM Management on Local Computer - a
Figure6 - 47
Prepare the TPM... TPM Actions Menu

Change Owner Password...
Clear TPM...
Reset TPM Lockout...

View b
New Window from Here

Refresh

~ M

Heln
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitLocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

& BitLocker Drive Encryption s =]

« v 4 “& « All Control Panel ltems > BitLocker Drive Encryption v O | Search Control Panel

Control Panel Home 5 z s
BitLocker Drive Encryption

Help protect your files and folders from unauthorized access by protecting your drives with

Figure 6 - 48 Bitlocker.
BitLocker Drive
Encryption Operating system drive

C: BitLocker off

IR

\‘ & Tumn on BitLocker :

Fixed data drives )
@ Turn on BitLocker

Removable data drives - BitLocker To Go

MEMSTICK (D:) BitLocker off

See also
9 TPM Administration
G Disk Management

Privacy statement
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Chapter 7: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off

for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call

your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors’ on page 1 - 8) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States’ on page 3 - 8), the Fn + F12 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive.
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Backup and General Maintenance

* Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

*  Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “ The Insyde Bl OS Utility” on page5 - 2).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

* Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

* Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

+ Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).
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Upgradmg and Adding New Hardware/Software

Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

*  When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).
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* Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

* Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 6) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
pages 3 - 17 to 3 - 22).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 19). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.
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Problem

Possible Cause - Solution

Nothing appears on screen.

The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 10).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Clickpad.

No image appears on the external
monitor | have plugged in and powered
on.

You haven't installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

2NZ
Z &

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot

remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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Problem

Possible Cause - Solution

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 11) to adjust.

Unwelcome when

typing.

numbers appear

Num Lock is turned ON (see “LED Indicators” on page 1 - 8).

| am sliding my finger up and down on the
right side of the Clickpad to scroll a
Window and the Clickpad does not
respond.

There are different Clickpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Clickpad (depending on the
scrolling direction required) to scroll the window.

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.
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Problem

Possible Cause - Solution

The screen appears to be upside down.

The screen rotation feature has been enabled. Use screen rotation (Fn + R) key
combination to rotate the screen again.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 8). Make sure you have enabled Hibernate mode from the control
panel.

| am trying to uninstall a driver (e.g. the
Intel Graphics driver) but it does not
appear in the Programs and Features
control panel in Windows.

If this is the case, the driver will need to be removed from the Device
Manager. Not all driver installation processes create an entry in Add or Remove
Programs. If it does not appear in the Programs and Features Control Panel, go
to Device Manager, select the hardware item (you may need to click on it to
expand the sub-menu), right-click the driver name, and select uninstall device
> Uninstall. Follow the on-screen instructions and then re-install the driver as
required.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Go to the Charms
Bar and select Settings and then click the WiFi icon (Airplane mode should be
Off).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 11). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 6 - 1).
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Problem Possible Cause - Solution

A file cannot be copied to/from a | The transfer of data between the computer and a Bluetooth enabled device is
connected Bluetooth device. supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

When using a Bluetooth headset the | This is a common issue with Bluetooth headsets. To resolve this issue do the
audio appears to be mono and not | following (you will need to repeat this procedure after every boot up, restart,
stereo. or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device (the
default device is Headset).

Click Connect to complete the stereo connection.

N—_O®wWN -~
P

w

. |
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Problem

Possible Cause - Solution

A file being copied to/from a connected
Bluetooth device appears to be
transferring very slowly.

You may have the Bluetooth control panel (Settings > Devices > Bluetooth)
open. When transferring data between the computer and a Bluetooth enabled
device, make sure that the Bluetooth control panel is closed.

2§

Bluetooth Control Panel
(Settings > Devices)

Close the Bluetooth control pan-
el (pictured on the right) when
transferring data between the com-
puter and a Bluetooth enabled de-
vice.

Bluetooth & other devices

] K B or oo v

oo
@ -

Pl sceverabie s DETOP HIABORT

Mouse. keyboard, & pen
U R sl Monte

Cther devices.
o W e v

] S ————
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Problem

Possible Cause - Solution

can’'t hear any sound from the

microphone in my connected headset,
when trying to test the audio playback.

You need to enable listening to the microphone in the audio control panel in
order to hear any sound through your connected headset as follows:

1. Right-click the volume control icon in the taskbar.
2. Select Recording Devices.
Open Volume Mooer
Playback devices
Recording devices
Sounds.
Troubleshoot sound problems
3. Double-click Microphone and select Listen.
4. Click to put a check in Listen to this device check box.
4 Microphane Properties
General LUsten |evels Enhancements Advanced
You can listen to a portable music player or other device through
Microphone jack. If you connect a microphone, you may hear feq
Listen to this device
5.  Click Apply.
6. You can then listen to the playback though the headset for testing.

7. Remember to disable this feature (remove the check from the Listen to
this device check box) otherwise you may hear an echo from the internal

Problems and Possible Solutions 7 - 13




Troubleshooting

7-14



Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports & Jacks

Item

Description

2-In-1 Combo Audio Jack
Headphone/Microphone

Q

Headphone / Microphone

Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Plug an external microphone in to this jack to record on your computer.

MicroSD Card Reader

B

The card reader allows you to use some of the latest MicroSD digital storage cards. Push the
card into the slot and it will appear as a removable device. The compatible MicroSD card formats
are listed below:

¢ microSD / microSDHC / microSDXC

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.
HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
Hom transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or

Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

RJ-45 LAN Jack

a1

This port supports LAN (Network) functions (you will need to open the cover slightly before
inserting a LAN cable).
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
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Item

Description

Security Lock Slot

(5 5,

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0 Type A Port

$

USB 3.2 Gen2 Type A&
Type C Ports

-

Thunderbolt 4 Combo
Port
(Type-C with Power
Delivery DC-In)

7

These USB ports are for low-speed peripherals such as keyboards, mice or scanners, and for
high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged from the computer, without the
need to turn the system off (if the power rating of your USB device is 500mA or above, make sure
you use the power supply which comes with the device).

USB 3.2 (Gen 2) ports are capable of 10Gbps (SuperSpeed USB 10Gbps).This model includes 1
*USB 2.0 (Type A) Port, 1 * USB 3.2 Gen 2 (Type A) port, 1 * USB 3.2 Gen 2 (Type C) port and
1 * Thunderbolt™ 4 Combo Port with Power Delivery DC-In (Type C).

This Thunderbolt 4 port allows for the connection of external peripherals to the computer by
combining PCI Express (PCle), DisplayPort (DP), USB and its own Thunderbolt 4 technologies.
Up to seven peripherals may be supported by one connector by daisy-chaining the devices.
Devices supported include HDDs/SSDs, Audio Interfaces, docks, display devices, cameras,
network cables etc.

The Thunderbolt 4 combo port supports Power Delivery with DC-In. This port allows you to use a
third party AC/DC adapter/laptop power bank plugged into the port as a power supply. If you are
using a power bank make sure that it complies with the USB-C PD (Power Delivery)
standard specification rated at 20V/65W - 20V/100W. If you are using a third party AC/DC
adapter, the rating of the adapter must be at least 20V, 3.25A (65 Watts) and it should be
appropriately certified.
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Item Description

Install the driver as instructed in “Thunderbolt Driver” on page 4 - 9. This will install the
Thunderbolt software to your computer, and this can be accessed by clicking or double-clicking

the Thunderbolt Control Center u in the Start menu.

Thunderbolt Port Devices

When plugging a device into a Thunderbolt port allow 30 seconds for the system to scan and recognize
the connected device. In order to prevent system problems make sure you do not simply pull the cable
out from the Thunderbolt port. The hardware must be ejected safely:

Go to the notification area of the taskbar and click on the Safely Remove Hardware and Eject

Media icon.

Click on Eject “Thunderbolt Device Name”.

When you see the “Safe to Remove Hardware” message you can remove the cable after
about 20 seconds, to make sure that it is safe to eject the device.

.|
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Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center application.

Control Center

The Control Center provides quick access to Power Modes, Fan and the LED Keyboard (for illuminated
colored keyboards only) configuration. Click icons to access the appropriate menu, and make adjustments as
applicable.
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Run the Control Center from the Windows Start menu or by clicking the icon in the notifica-
tion area of the taskbar.

(5 Gl Note the LED Key-
board item will ap-
pear for colored LED
keyboards only.

CONTROL CEATES 5.0

(s

COoOMNTROL CanTER 5.0

3823 rem

Figure B - 1 - Control Center Screens
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Fan Speed Setting

You can access the Fan Speed Setting from the Control Center or the Windows Start menu

2 Fan Speed Setting

Set the fan speed to Maximum (full power) or Automatic from this menu item. The fan speed will adjust itself
automatically to control the heat of the CPU. However you can adjust the setting to maximum if you prefer. You

can use the Offset slider to adjust the settings to your preference, however these settings can be overridden by
the system as a safety precaution, if it requires heavier use of the fan.

Fan Speed

ny
(=]

3
Y TN

Temparature

3823 rem

Figure B - 2 - Fan Settings
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Power Modes

Power Modes allows you to adjust the power mode by clicking the appropriate icon.

(&

CONTROL CENTER 5.0

Figure B - 3 - Power Modes

* Power Saving mode focuses on saving battery life (the CPU Turbo Boost is On and dGPU Turbo is Off).
* Quiet mode focuses on reducing fan noise and will decrease both CPU power and dGPU power.

* Entertainment balances CPU and dGPU power and is ideal for watching videos etc.

* Performance mode is ideal for gaming with higher CPU and dGPU performance.

Note: You can use the Fn +3 key combination to quickly toggle through, and select, the Power Modes.

. |
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llluminated LED Keyboard

The LED Keyboard menu will allow to change the Brightness and Keyboard Sleep Timer. The LED Key-
board application can be accessed by clicking LED Keyboard in the Control Center, or from the Windows
Start menu POEE

=

4

Override Boot Effect

On boot the colored key-
board will momentarily
flash. You can click in the
Override Boot Effect
check box to disable the
keyboard flashing effect
as the system boots.

Keyboard

Figure B - 4 - LED Keyboard Setting

. |
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Appendix C: Video Driver Controls ~

Overview Video Controller
. . . Options

The video features for this computer can be configured using the Windows Display

Settings or Intel Graphics Command Center. Note that video control-
ler types, specifications
and drivers are subject
to continual updates and
changes. Check with
your distributor/supplier
for the latest details on
video controllers sup-
ported.

. |
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4

Display Settings

Note: After installing
the video driver go to
the Display/Display
Settings control panel
to adjust the video set-
tings to the highest res-
olution.

Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.
Insert the Device Drivers & Ultilities + User’s Manual disc into an attached DVD
drive and click Install Drivers (button).

SANAEF I

10.
11.

12.

Click 3.Install VGA Driver > Yes.

Click Begin Installation.

Click the check box to agree to the terms and conditions and click Next.
Click Start.

Click Reboot now to restart the computer.

Intel Graphics Command Center will download but you will need to have
a working internet connection.

Click the Start menu in Windows to access the Microsoft Store App tile
under Explore.

Click the Sign in icon R, and select Downloads and updates.

Click Check for Updates and a list of apps being downloaded will pop-up.
To prioritize the driver you can click Pause all to pause the download queue.

Click on Intel Graphics Command Center and click on the resume icon
O to download the driver.

When finished the Intel Graphics Command Center will appear in the
Windows Start menu.
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Configure Other Displays Using Project

You can configure attached displays from Project.

1.
2.
3.

Attach your display to the appropriate port, and turn it on.

Press the g@ + P key combination.

Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

You can also click Connect to a wireless display at the bottom of the Project
screen and follow the steps to connect to any wireless enabled display.

Project

PC screen only

Duplicate Flgure C - 1
Project

Second screen only
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Configuring an External Display In Windows

The System > Display Control Panel in Settings may also be used to configure dis-

plays.

1. Attach your external display to the appropriate port, and turn it on.

2. Click the Start Menu and click Settings > System (or right-click the desktop and
select Display Settings).

3. Click the Multiple Displays menu and select Duplicate these displays, Extend
these displays or Show only on 1/2.

4. Click Keep changes to save any changes made.

@ Home Djsplay Select and rearrange displays

Select a display below to change its settings. Some settings are applied to all displays.

“|  Brightness and color

System (Change brightness for the bullt-in displsy
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O Battery
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5. You can configure up to 3 displays (including the notebook display) from the
System > Display menu.

@

Settings

Home

==’

i
|
D

B

Configuring an External Display In Windows C - 5

] Find a setting

System

Display

Seund

Motifications & actions

Focus assist

Power & sleep

Battery

Storage

Tablet mode

Multitasking

Projecting to this PC

Shared experiences

Display
Rearrange your displays

Select a display below to change the settings for it. Press and hold (or select) a display, then
drag to rearrange it.

EN - B

Identify Detect

Brightness and color

Change brightness for the built-in display

Might light
@ on

Might light settings
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4

3 Displays

Note that when 3 dis-
plays are configured,
only 2 displays may be
set to Duplicate mode.

FigureC-3
System > Display
(3 Displays)
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4

Volume Adjustment

The sound volume level
can be clicking using the
volume control icon [p)|

in the notification area
of the taskbar.

FigureC-4
Sound - HDMI
Device (set Default)

HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1. Go to the Sound control panel.
2. Click Playback (tab)
3. The playback device will be selected.
4. You may need to select the audio device and click Set Default (button).
5. Double-click the device to access the control panel tabs.

¥ Sound ®

Playback Recording Sounds Communications

B ™ i =

R, 5 »

Realtek(R) Audio
Ready

ﬁ SDEEEEI'!

Set Default moeme:

Apply

Configure
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6. Adjust the HDMI settings from the control panel tabs.

7. Click OK to close the Sound
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HDMI Notes
A * Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.
* To play audio sources through your external display’s (TV or LCD) speakers
If you are using a third you will need to go to the audio configuration control panel on the display and

party application to play .. . . .
b configure the audio input accordingly (see your display device manual).

ti‘i]hjv?" ng;/(?to Sg:iscji HDMI Video Configuration
y 1. Connect an HDMI cable from the HDMI-Out port to your external display.

the application’s docu- . . . . .
el 5 cEm e 2. Configure your external display as per the instructions in “” on page C - 23.

Other Applications

appropriate audio con- 3. Set up your external display (TV or LCD) for HDMI input (see your display device
figuration (the applica- manual).
tion must support digital 4. You can now play video/audio sources through your external display.

to analog translation).

.|
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Wireless Display Configuration

1. Note that no driver or application is required for wireless display in Windows 10.

2. Pressthe g@ + P key combination.

3. Click Connect to a wireless display at the bottom of the Project screen and
follow the steps to connect to any wireless enabled display.

Project

PC screen only

Duplicate Flgure C - 6
Add a Wireless
Display

Second screen only

4. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).
5. Double-click any detected display device in the list.

Wireless Display Configuration C - 9
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6. You may then need to input a pin number for the device to which you are
connecting and click Next.

7. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

8. Go to the Project menu and click Disconnect to temporarily disconnect from the
wireless display.

9. To permanently disconnect from the display (you will need to go back through the
connection process again) you can select it in Devices and click Remove Device
> Yes.

C - 10 Wireless Display Configuration
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Intel® Graphics Command Center

Advanced video configuration options are provided by the Intel Graphics Com-
mand Center.

1. Access the Intel Graphics Command Center from the Start menu in Windows.

FigureC-7
Intel® Graphics
Command Center
(Windows Start
Menu)

Play music
love. No credit
cards.

Spotify @ Your Phone

> m A=

pel 'I'ype here to search
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OR
2. You can right-click the Intel Graphics Command Center in the Start menu and
pin the control panel to the taskbar.

FigureC-8
Intel® Graphics
Command Center
(right-click to Pin to
taskbar)

Microsoft Store

Spotify @  Your Phone

£ Type here to search g @ ™ ﬁ m 0 & -
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Y ou may make changes to any of the graphics properties by clicking the appropriate

icon on the left and you and then adjust the settings from the sub-menus. 4
Home
intel  Graphics Command Canter Garmes Capture @ Global Settings
— Click the Home button to
return to the main menu
The Perfect Experience Awaits g : i screen in any of the sub-
You ey g menu screens.
Livk all your games in s few : e
unlos erful optimi:
YOUr Barmes.
Serious 5am 4 .
, gy FigureC-9
Jorted games e arsenal, intergala H
which crds dpe Intel® Graphics

Command Center
(Home Screen)

Manually Select

Select a game 3 your library.
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Display
Z . Click either General or Color to make display adjustments, including configuration
Multiple Display for any attached external displays.

At least one other dis-

Connected Displays

play must be attached in

order to view multiple

display selection op-
| tions.

Detect

- Display

FigureC- 10
Intel® Graphics
Command Center
(Display Screen)

1920 x 1080 {Recommendad)

content is displayed.

Open System Settings
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Use the Display menu to adjust the display’s Resolution, Refresh Rate, Scale, and
Rotation, and to access the Display control panel in System Settings. Z

Custom
Connected Displays Resolutions
identify  Detect
The Custom Resolu-
tions sub-menu allows
you to adjust supported
displays to any Timing
Standard, Width,

Display

Height, Refresh Rate
and Underscan percent-
age of your choice.

Information

Note that incorrect set-
tings can cause system
instability and even pos-
sible component dam-
age, so this is adjusted
at your own risk.

VALUE

1620 x 1080
at can be displayed on s

FigureC- 11
Intel® Graphics
Command Center

(Display)

Open System Settings
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‘ When external displays are attached you can use the Connected Displays control
Z | panel to configure multiple displays (see “ Attaching Other Displays’ on page C -
24). Click on the dotted lines at the top right of the display graphic to access the set-

Multiple Display
tings options and click Apply to save any changes made.
At least one other dis-
play must be attached in
order to view multiple
display selection op-

tions.

Connected Displays

Mentify  Detect  Apply  Help

Audio Settings Display

Any attached active dis-

plays must have audio

capacity to allow audio
| configuration.

FigureC- 12
Intel® Graphics
Command Center
Connected Displays

Rotation (7)

Dpen System Settings
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The Custom Resolutions sub-menu allows you to adjust external displays support-
ing this feature to any Timing Standard, Width, Height, Refresh Rate and Underscan
percentage of your choice. Note that incorrect settings can cause system instability
and even possible component damage, so this is adjusted at your own risk.

Custom Resolution

FigureC- 13
Intel® Graphics
Command Center
Custom
Resolutions

Intel® Graphics Command Center C - 17
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Display (Color)
Use the color sliders from the menu to make changes to the display. If you wish to
revert to the default settings simply click on Restore to Original Colors.

Connected Displays

idenify  Detect  Apply  Help

FigureC- 14 - Display
Intel® Graphics
Command Center
(Display - Color
Screen) pra——
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Video

The Video menu allows you to brighten or darken movies, adjust colors and a range
of other video options. The Preview image will display a sample image using the
current settings, and you can click Add Video to select your own sample video. You
will need to click Custom to create a custom profile to make adjustments to most
of the settings and you can rename, duplicate or delete custom profiles.

FigureC- 15
; N Intel® Graphics
- Video 2 'm Command Center
: (Video)

Video Profiles  Restore to Original Settings

* | righten Video

ken Video
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FigureC- 16
Intel® Graphics
Command Center
(System - Hotkeys)

System

Hot Keys in System allows you to create and enable/disable hot keys for opening
the application and display rotation etc. Click Apply to save changes. The Driver
and Hardware tabs provide information on your current video driver version and
hardware configuration.

Cirl # Al
Cirl + Al

Cirl o Al

Cirl + Alt

.|
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Support

Online Resources in Support provides links to online support for Intel graphics is-
sues and to the latest drivers. The System Diagnostic tab allows you to Generate
Report on the graphics system (as may be required by online help services).

intel Grap

Self-Help Support for Intel*
Graphics Drivers

FigureC - 17
Intel® Graphics
Command Center
(System - Support)

- Support
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Preferences
You can configure the app to your preferences from this menu.

‘ommand Center =
Gene

SETTINGS

System Tra

Le 1 oading

Promotions
Show affers from game developers

. iz Notifications
FI gure C - 18 Sestert W will notity you when an update & available.
Intel® Graphics . Stow Ganes
com m and ce nter Turn off to hide this feature on work comgaiterns.

- Preferences
(Prefe rences) " & & backpground image of the app.

.|
C - 22 Intel® Graphics Command Center



Video Driver Controls

Display Devices & Options i~
You can use external displays connected to the HDMI-Out port and/or Thunderbolt =
Combo Port.

4K2K Videos on 4K2K
External Displays

Note you may experi-
ence some video lag
when playing 4K2K vid-

Intel Display Mode Description

One of the connected displays is used as the display device (PC

ingle Displ

Single Display screen only or Second screen only). =08 SO el e_lttached
4K2K external display.

Mi Both connected displays output the same view and may be

irror . )

configured independently.
: : TableC-1

Extend Both connected displays are treated as separate devices, and act as

Display Modes

a virtual desktop.

Attaching Displays

When you first attach an
external display you may
find that the desktop does

not occupy the full screen
area. Use either the dis-
play’s auto adjust/configure
controls, or the Intel Graph-
ics Command Center to
configure the full screen
display.

Display Devices & Options C - 23
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4

Connected Displays

At least one other dis-
play must be attached in
order to view Connect-
ed Displays selection
options.

FigureC- 19
Display > Mirror

Attaching Other Displays

To Mirror Displays:

Attach your external display to the appropriate port, and turn it on.

Go to the Intel Graphics Command Center and click the Display menu button.
Click Detect if you need to scan for any attached displays.

The system should automatically be in Mirror mode,

If not, click on the dotted lines at the top right of the display graphic to access the
settings options and select Mirror and the Monitor #.

Click Apply to confirm any settings change if necessary.

oo~

o

Kantify  Detect  Apply

1920 x 1080 (Recommanded]
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To Enable Extend Mode:

1.
2.
3.
4

5.

Attach your external display to the appropriate port, and turn it on.

Video Driver Controls

Go to the Intel Graphics Command Center and click the Display menu button.

Click Detect if you need to scan for any attached displays.

Click on the dotted lines at the top right of the display graphic to access the

settings options and select Extend and the Monitor #.
Click Apply to confirm any settings change if necessary.

Connected Displays

FigureC- 20
Display > Extend

Attaching Other Displays C - 25
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6. You can have different resolutions, monitor refresh rates, scales, rotations and
aspect ratios for each display device provided your display can support them.

7. You can drag the display icons to match the physical layout of your displays.

8. lcons and programs may also be dragged between the displays.

Connected Displays

Display

FigureC- 21
Display > Extend
(Drag Display)

Click the appropriate monitor icon and drag it to match the physical arrangement
you wish to use (e.g. the secondary display may be extended left/right/above/be-
low the primary display).

.|
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Specifications
Appendix D: Specifications
A

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

Note that this computer model series may support a range of CPUs and/or video adapters.

To find out which CPU is installed on your system go to the Start menu and select Settings, and then select System and
click About. This will also provide information on the amount of Installed RAM etc.

To get information on your system’s video adapter go to the Start menu and select Settings, and then select System and
click Display> Advanced display settings > Display adapter properties.

.|
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Specifications

For Model A Series Computers:
15.6” / 39.62cm, FHD (1920 * 1080),
16:9, 3.2mm Thick Backlit Panel

For Model B Series Computers:
17.3" /1 43.94cm, FHD (1920 * 1080),
16:9, 3.5mm Thick Backlit Panel

Dual Channel DDR4

Memory Expandable up to 64GB Compatible
with 8GB, 16GB or 32GB Modules

Two 260 Pin SO-DIMM Sockets
Supporting DDR4 3200MHz (processor
dependent) Memory Modules (real
operational frequency depends on the
FSB of the processor)

One M.2 SSD 2280, PCle Gen 4*4
Interface

One M.2 SSD 2280, SATA / PCle Gen
3*4 Interface (RAID 0/1 on PCle 3*4
interface only)

D - 2 Specifications

High Definition Audio Interface
2 * Built-In Speakers
Built-In Array Microphone

Built-in Click Pad with Microsoft PTP
Multi-Gesture and Scrolling Functionality
OR

Built-in Secure Pad with Microsoft PTP
Multi-Gesture and Scrolling Functionality
(Model A Only)

Full Size Keyboard with Numeric Keypad
OR

Multi-Colored llluminated Backlit
Keyboard with Numeric Keypad (Factory
Option)

One USB 2.0 Port (Type A)

One USB 3.2 Gen 2 Port (Type-A)
*One Thunderbolt 4 Combo Port with
Power Delivery DC-In (Type-C)

One USB 3.2 Gen 2 Port (Type-C)

*Note: The power output of the Thunderbolt 4
Combo Port is 5V/3A in AC mode or 5V/1.5A in
DC mode.

The Thunderbolt 4 Combo Port supports Power
Delivery with DC-In. This port allows you to use a
third party AC/DC adapter/laptop power bank
plugged into the port as a power supply.

If you are using a power bank make sure that it
complies with the USB-C PD (Power Delivery)
standard specification rated at 20V/65W - 20V/100W.

If you are using a third party AC/DC adapter, the
adapter rating must be at least 20Volts, 3.25A (65
Watts), and it should be appropriately certified.

Note: The maximum amount of current supplied
by USB ports is 500 mA for USB2.0/900 mA for
USB 3.2 & Type C.

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One 2-in-1 Audio Jack (Headphone /
Microphone Combo)

One RJ-45 LAN Jack

One DC-In Jack




Micro SD Card Reader

Three M.2 Card Slots:

Slot 1 for M.2 2230 WLAN Combo Module
with PCle / USB / CNVi Interface (E Key)

Slot 2 for SSD M.2 2280 Card with PCle
Gen 4*4 Interface (M Key)

Slot 3 for SSD M.2 2280 Card with SATA
/ PCle Gen 3*4 Interface (M Key)

Built-In 10/100/1000Mb Base-TX
Ethernet LAN

1.0M HD WebCam Module with USB
interface

OR

Windows Hello Camera (Factory Option)
Intel® Dual Band Wi-Fi 6 AX200 2*2 AX

WLAN + Bluetooth Combo PCle M.2
2230 Module (Factory Option)

Intel® Dual Band Wi-Fi 6 AX-201 2*2
AX WLAN + Bluetooth CNVi M.2 2230
Module (Factory Option)

Specifications

Intel® Dual Band Wireless-AC 9462 1*1
AC WLAN + Bluetooth M.2 2230 Combo
Module (Factory Option)

Supports Wake on USB

Supports Wake on LAN (AC Mode Only)
Windows Modern Standby

Supports Wake on RTC Alarm (AC Mode
Only)

Full Range AC/DC Adapter - AC input
100 - 240V, 50 - 60Hz, DC Output 19V,
3.42A (65 Watts)

Embedded Polymer Smart Lithium lon
Battery Pack 36 WH

Embedded Polymer Smart Lithium lon
Battery Pack 73WH(Factory Option)

Security (Kensington® Type) Lock Slot
BIOS Password

Intel® PTT for systems without TPM
Trusted Platform Module 2.0 (Factory
Option)

Area Fingerprint (Factory Option for
Model A only)

Shipping Mode
FlexiCharger
Intel® Optane™ Technology

Windows® 10 20H2 (64-bit)

Power/Suspend, Battery & Webcam

One 128Mb SPI Flash ROM
Insyde BIOS

Temperature
Operating: 5°C-35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

Specifications D - 3




Specifications

For Model A Series Computers:
357mm (w) * 220.5mm (d) * 19.9mm (h)
1.6kg *Barebone System with 36WH
Battery

For Model B Series Computers:
395mm (w) * 250.7mm (d) * 19.8mm(h)
2.05kg *Barebone System with 36WH
Battery

2.25kg *Barebone System with 73WH
Battery

*A barebone system does not include the HDD,
RAM, adapter, power cord and factory option
modules (weight tolerance within +/- 5%).

.|
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